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Preface

This guide describes CiscoView Device Manager for SSL Services Module
(CVDM-SSLSM) and describes common tasks you can accomplish with
CVDM-SSLSM.

Audience

This document is for the experienced network operator, security operator, or super
administrator managing Cisco Catalyst 6500 family of switches.

Conventions

This document uses the following conventions:

Item Convention
Commands and keywords boldface font
Variables for which you supply values italic font

Displayed session and system information screen font

Information you enter boldface screen font
Variables you enter italic screen font
Menu items and button names boldface font
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Item Convention
Selecting a menu item in paragraphs Option > Network Preferences
Selecting a menu item in tables Option > Network Preferences

Note = Means reader take note. Notes contain helpful suggestions or references to
material not covered in the publication.

Product Documentation
A

Note = We sometimes update the printed and electronic documentation after original

publication. Therefore, you should also review the documentation on Cisco.com
for any updates.

Table 1 describes the product documentation that is available.

Table 1 Product Documentation

Document Title Available Formats

Release Notes for CiscoView This document is available on Cisco.com at this URL:
Device Manager for the Cisco http://www.cisco.com/en/US/products/sw/cscowork/ps4565/

Catalyst 6500 Series SSL Services |prod_release_notes_list.html
Module (CVDM-SSLSM)

User Guide for CiscoView Device |This document is available on Cisco.com at this URL:
Manager for the Cisco Catalyst http://www.cisco.com/en/US/products/sw/cscowork/ps4565
6500 Series SSL Services Module |/products_user_guide_list.html

(CVDM-SSLSM)

Context-sensitive online help Click the Help button from any dialog box within the application.
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Related Documentation W

Related Documentation

A

Note = We sometimes update the printed and electronic documentation after original
publication. Therefore, you should also review the documentation on Cisco.com
for any updates.

Table 2 describes the additional documentation that is available.
Table 2 Related Documentation

Document Title

Available Formats

ReadMe Document for CiscoView
Device Manager for Cisco
Catalyst 6500 (CVDM-C6500)

This document is available if you download CVDM-C6500 from
the software download site. You can reach the CVDM-C6500
download site by clicking the Software Center link from this URL:
http://www.cisco.com/go/cvdm

Note It is important that you read this document before
downloading and installing CVDM-C6500 from the

software download site.

Release Notes for CiscoView
Device Manager for Cisco
Catalyst 6500 (CVDM-C6500)

This document is available on Cisco.com at this URL:
http://www.cisco.com/en/US/products/sw/cscowork/ps4565/
prod_release_notes_list.html

User Guide for CiscoView Device
Manager for Cisco Catalyst 6500

This document is available on Cisco.com at this URL:
http://www.cisco.com/en/US/products/sw/cscowork/ps4565
/products_user_guide_list.html

ReadMe Document for CiscoView
Device Manager for Cisco Content
Switching Modules (CVDM-CSM)

This document is available if you download CVDM-CSM from
the software download site. You can reach the CVDM-CSM
download site by clicking the Software Center link from this URL:
http://www.cisco.com/go/cvdm

Note It is important that you read this document before
downloading and installing CVDM-CSM from the

software download site.

| oL-6014-02
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Table 2 Related Documentation (continued)
Document Title Available Formats
Release Notes for CiscoView This document is available on Cisco.com at this URL:

Device Manager for Cisco Content |http://www.cisco.com/en/US/products/sw/cscowork/ps4565/
Switching Modules (CVDM-CSM) |prod_release_notes_list.html

User Guide for CiscoView Device |This document is available on Cisco.com at this URL:
Manager for Cisco Content http://www.cisco.com/en/US/products/sw/cscowork/ps4565
Switching Modules (CVDM-CSM) |/products_user_guide_list.html

Obtaining Documentation

Cisco documentation and additional literature are available on Cisco.com. Cisco
also provides several ways to obtain technical assistance and other technical
resources. These sections explain how to obtain technical information from Cisco
Systems.

Cisco.com

You can access the most current Cisco documentation at this URL:
http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:
http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation DVD

Cisco documentation and additional literature are available in a Documentation
DVD package, which may have shipped with your product. The Documentation
DVD is updated regularly and may be more current than printed documentation.
The Documentation DVD package is available as a single unit.
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Documentation Feedback

Registered Cisco.com users (Cisco direct customers) can order a Cisco
Documentation DVD (product number DOC-DOCDVD=) from the Ordering tool
or Cisco Marketplace.

Cisco Ordering tool:
http://www.cisco.com/en/US/partner/ordering/
Cisco Marketplace:

http://www.cisco.com/go/marketplace/

Ordering Documentation

You can find instructions for ordering documentation at this URL:
http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm
You can order Cisco documentation in these ways:

e Registered Cisco.com users (Cisco direct customers) can order Cisco product
documentation from the Ordering tool:

http://www.cisco.com/en/US/partner/ordering/

e Nonregistered Cisco.com users can order documentation through a local
account representative by calling Cisco Systems Corporate Headquarters
(California, USA) at 408 526-7208 or, elsewhere in North America, by
calling 1 800 553-NETS (6387).

Documentation Feedback

You can send comments about technical documentation to bug-doc @cisco.com.

You can submit comments by using the response card (if present) behind the front
cover of your document or by writing to the following address:

Cisco Systems

Attn: Customer Document Ordering
170 West Tasman Drive

San Jose, CA 95134-9883

We appreciate your comments.
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Cisco Product Security Overview

Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.ht
ml

From this site, you can perform these tasks:
e Report security vulnerabilities in Cisco products.
e Obtain assistance with security incidents that involve Cisco products.
e Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at
this URL:

http://www.cisco.com/go/psirt

If you prefer to see advisories and notices as they are updated in real time, you
can access a Product Security Incident Response Team Really Simple Syndication
(PSIRT RSS) feed from this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products

Tip

Cisco is committed to delivering secure products. We test our products internally
before we release them, and we strive to correct all vulnerabilities quickly. If you
think that you might have identified a vulnerability in a Cisco product, contact
PSIRT:

¢ Emergencies—security-alert@cisco.com

e Nonemergencies—psirt@cisco.com

We encourage you to use Pretty Good Privacy (PGP) or a compatible product to
encrypt any sensitive information that you send to Cisco. PSIRT can work from
encrypted information that is compatible with PGP versions 2.x through 8.x.
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Never use a revoked or an expired encryption key. The correct public key to use
in your correspondence with PSIRT is the one that has the most recent creation
date in this public key server list:

http://pgp.mit.edu:11371/pks/lookup?search=psirt%40cisco.com&op=index&ex
act=on

In an emergency, you can also reach PSIRT by telephone:
e 1877 228-7302
e 1408 525-6532

Obtaining Technical Assistance

For all customers, partners, resellers, and distributors who hold valid Cisco
service contracts, Cisco Technical Support provides 24-hour-a-day,
award-winning technical assistance. The Cisco Technical Support Website on
Cisco.com features extensive online support resources. In addition, Cisco
Technical Assistance Center (TAC) engineers provide telephone support. If you
do not hold a valid Cisco service contract, contact your reseller.

Cisco Technical Support Website

The Cisco Technical Support Website provides online documents and tools for
troubleshooting and resolving technical issues with Cisco products and
technologies. The website is available 24 hours a day, 365 days a year, at this
URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support Website requires a Cisco.com
user ID and password. If you have a valid service contract but do not have a user
ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

| oL-6014-02
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~

Note

Use the Cisco Product Identification (CPI) tool to locate your product serial
number before submitting a web or phone request for service. You can access the
CPI tool from the Cisco Technical Support Website by clicking the Tools &
Resources link under Documentation & Tools. Choose Cisco Product
Identification Tool from the Alphabetical Index drop-down list, or click the
Cisco Product Identification Tool link under Alerts & RMAs. The CPI tool
offers three search options: by product ID or model name; by tree view; or for
certain products, by copying and pasting show command output. Search results
show an illustration of your product with the serial number label location
highlighted. Locate the serial number label on your product and record the
information before placing a service call.

Submitting a Service Request

Using the online TAC Service Request Tool is the fastest way to open S3 and S4
service requests. (S3 and S4 service requests are those in which your network is
minimally impaired or for which you require product information.) After you
describe your situation, the TAC Service Request Tool provides recommended
solutions. If your issue is not resolved using the recommended resources, your
service request is assigned to a Cisco TAC engineer. The TAC Service Request
Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the
Cisco TAC by telephone. (S1 or S2 service requests are those in which your
production network is down or severely degraded.) Cisco TAC engineers are
assigned immediately to S1 and S2 service requests to help keep your business
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts
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Definitions of Service Request Severity

To ensure that all service requests are reported in a standard format, Cisco has

established severity definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your

business operations. You and Cisco will commit all necessary resources around

the clock to resolve the situation.

Severity 2 (S2)—Operation of an existing network is severely degraded, or
significant aspects of your business operation are negatively affected by

inadequate performance of Cisco products. You and Cisco will commit full-time

resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most

business operations remain functional. You and Cisco will commit resources
during normal business hours to restore service to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product
capabilities, installation, or configuration. There is little or no effect on your
business operations.

Obtaining Additional Publications and Information

Information about Cisco products, technologies, and network solutions is
available from various online and printed sources.

e Cisco Marketplace provides a variety of Cisco books, reference guides, and
logo merchandise. Visit Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

e Cisco Press publishes a wide range of general networking, training and

certification titles. Both new and experienced users will benefit from these

publications. For current Cisco Press titles and other information, go to Cisco

Press at this URL:
http://www.ciscopress.com

e Packet magazine is the Cisco Systems technical user magazine for
maximizing Internet and networking investments. Each quarter, Packet

delivers coverage of the latest industry trends, technology breakthroughs, and

Cisco products and solutions, as well as network deployment and
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troubleshooting tips, configuration examples, customer case studies,
certification and training information, and links to scores of in-depth online
resources. You can access Packet magazine at this URL:

http://www.cisco.com/packet

iQ Magazine is the quarterly publication from Cisco Systems designed to
help growing companies learn how they can use technology to increase
revenue, streamline their business, and expand services. The publication
identifies the challenges facing these companies and the technologies to help
solve them, using real-world case studies and business strategies to help
readers make sound technology investment decisions. You can access iQ
Magazine at this URL:

http://www.cisco.com/go/igmagazine

Internet Protocol Journal is a quarterly journal published by Cisco Systems
for engineering professionals involved in designing, developing, and
operating public and private internets and intranets. You can access the
Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

World-class networking training is available from Cisco. You can view
current offerings at this URL:

http://www.cisco.com/en/US/learning/index.html
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CHAPTER 1

Getting Started with CVDM-SSLSM

The CiscoView Device Manager for Cisco Catalyst 6500 SSL Services Module is
an embedded device manager for single service module setup, feature and
services configuration, and monitoring of the services module.

SSLSM Overview

The Secure Socket Layer Services Module is a Layer 4-through-Layer 7 service
module that you can install into the Catalyst 6500 series switch. The module
terminates secure socket layer (SSL) transactions and accelerates the encryption
and decryption of data used in SSL sessions.

The module operates either in a standalone configuration or with the Content
Switching Module (CSM). In a standalone configuration, secure traffic is directed
to the module using policy-based routing (PBR). When used with the CSM, only
encrypted client traffic is forwarded to the module, while clear text traffic is
forwarded to the real servers.

The SSLSM uses the SSL protocol to enable secure transactions of data through
privacy, authentication, and data integrity; the protocol relies upon certificates,
public keys, and private keys.

The certificates, which are issued by certificate authority and are similar to digital
ID cards, verify the identity of the server to the clients and the clients to the server.
The certificates include the name of the entity to which the certificate was issued,
the public key of the entity, and the time stamp that indicates the certificate
expiration date.

| oL-6014-02
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M Before You Begin

The public and private keys are the ciphers that are used to encrypt and decrypt
information. The public key is shared without any restrictions, but the private key
is never shared. Each public-private key pair works together; data that is
encrypted with the public key can only be decrypted with the corresponding
private key.

This chapter includes the following topics:

Before You Begin, page 1-2

What’s New, page 1-3

Key Features in CVDM-SSLSM, page 1-4

Starting CVDM-SSLSM, page 1-5

Navigating in CVDM-SSLSM, page 1-6

Editing the Preferences, page 1-21

What Does the Setup Page Show Me?, page 1-17
Viewing Running Configuration, page 1-22
Delivering CLI Commands to the Device, page 1-22
What’s Next?, page 1-24

Before You Begin

Before you begin using CVDM-SSLSM:

Make sure you have gone through the CVDM-SSLSM Readme and Release
Notes.

Install the necessary Java Plug-in

Make sure you have necessary privileges. Privilege level 15 is ideal.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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What's New

The new features in this release are:

Table 1-1 New Features for CVDM-SSLSM 1.1
Feature Description
Public Key Infrastructure New features are:

e Import private key in Netscape Server Key (NET) format and
certificates in DER format.

e Import unencrypted keys.

e Import certificate chain in PEM and PKCS7 format.
e Certificate and private key validations.

e Bulk export of certificates.

e Export certificates to a redundant SSLSM.

e Certificate Browser.

Statistics e Statistics at proxy service granularity.
e Delta monitoring.
e Option to reset the counters.

¢ Auto refresh of statistics.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Key Features in CVDM-SSLSM

The following table describes the key features of CVDM-SSLSM:

Table 1-2 Key Features

Feature Description

Public Key Infrastructure |CVDM-SSLSM allows you to:

e Manage Certificates:
— Declare Trustpoints, import and export certificates
— Visual indication of expiring and missing configured certificates.

— Grouping of the Trustpoints by CA, enrollment status, and
expiration date.

— Certificate Wizards to create and enroll certificates, import and
export certificates.

¢ (Create and manage Key Pairs
¢ Create and manage ACLs

¢ Create and manage certification authority pools

Proxy Service CVDM-SSLSM allows you to set up server proxy, client proxy and enable
backend encryption service using this feature.

Policies CVDM-SSLSM allows you configure SSL policy, TCP, header insertion,
and URL rewrite policies.

Statistics CVDM-SSLSM shows you the TCP, SSL, and PKI statistics.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Starting CVDM-SSLSM

Step 1

Step 2
Step 3
Step 4
Step 5

Step 6
Step 7

Step 8
Step 9

In your browser, enter the IP address or DNS hostname of the SSLSM. The Enter
Network Password dialog box appears.

Enter your SSLSM username and password.
Click OK. The CVDM splash screen appears.
Enter your device username and password.

Click Yes. The Warning - Security dialog box appears. To accept the security
certificate and continue, click Yes.

The SSH Credentials dialog box appears.

Enter your SSH username and password. The Enter Enable Password dialog box
appears.

Enter enable password.

Click OK. CVDM-SSLSM homepage appears.

Installing the Java Plug-in

You need to install the Java Plug-in. Java Plug-in improves the performance of
CVDM-SSLSM and allows the application to use the latest Java runtime
functionality. For CVDM, the plug-in speeds up caching and application loading.
CVDM-SSLSM requires the Java Plug-in version 1.4.2_04.

The first time you invoke any Java Plug-in window, you are alerted if the plug-in
is not installed. CVDM-SSLSM prompts you to download and install the plug-in
files, using the installation screens or the procedure displayed. The next time you
start the application, CVDM-SSLSM automatically uses the plug-in. Install the
Java Plug-in provided with CVDM-SSLSM.

| oL-6014-02
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Navigating in CVDM-SSLSM

Before you begin using CVDM-SSLSM, you must understand the basic operation
of the user interface, including the login procedure and user interface elements.
See the following sections for more information:

e Understanding the CVDM-SSLSM Desktop, page 1-7
e What Does the Home Page Show Me?, page 1-11

¢ What Does the Setup Page Show Me?, page 1-17

e Understanding the Action Buttons, page 1-20

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Understanding the CVDM-SSLSM Desktop

This section describes the main GUI elements of the CVDM-SSLSM application
(see Figure 1-1).

Figure 1-1 CVDM-SSLSM GUI Elements
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Figure 1-1
Reference |Location Description

1 Menu bar Provides File, Edit, View, and Help options.
e TFile

— File > Save to Startup—Saves the configuration running on the
device as the startup configuration.

— File > Exit—Logs you out of CVDM-SSLSM and closes the
application. A warning appears if any configuration has not been
applied to the SSLSM.

e Edit

— Edit > Preferences—Displays the Preferences dialog box, from
which you can edit application preferences. For details, see
Editing the Preferences, page 1-21

* View
- View > Home—Displays the Home page.
— View > Setup—Displays the Features page.

— View > Running Config > SSLSM...—Displays the configuration
running on the SSLSM. FOr details, see Viewing Running
Configuration, page 1-22

— View > Refresh—Collects the most recent device information and
updates CVDM-SSLSM with it.

— View > Transport Log...—Displays the transport log of the
device. You can clear the log or save the information to a file.

e Help
— Help > Help Topics—Displays online help.
- Help > About—Displays CVDM-SSLSM version information.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Figure 1-1
Reference

Location

Description

2

Task bar

Provides access to CVDM-SSLSM functionality.
e Home—Displays the home page.
e Setup—Displays the features page.

e Refresh—Collects the most recent device information and updates
CVDM-SSLSM with it.

e Deliver—Opens the Deliver Configuration to SSLSM dialog box,
from which you can send accumulated CLI commands to the device.
For details, see Delivering CLI Commands to the Device, page 1-22

e Help—Displays context-sensitive help.

Page

CVDM-SSLSM working area in which you perform tasks.

Pane

One part of a divided page or dialog box.

Status bar

Provides the following information:
e Message describing the status of the application.
e Application user and privilege level.
e Icon showing the security level of the connection.

e Time stamp of the application startup time.

Selector

Hierarchy of the groups and objects available on the services page that
allows you to access specific functions for a service module object. See
“Selector” section on page 1-18 for more information.

Left-most
pane

Contains buttons, on the setup page, that allow you to access SSLSM
functions.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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What Does the Home Page Show Me?

The home page is the first screen that comes up when you start CVDM-SSLSM.
It provides an overview of CVDM-SSLSM (see Figure 1-2).

Figure 1-2 CVDM-SSLSM Home Page
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Table 1-3 CVDM-SSLSM Home Page Elements and Description

Figure 1-3

Reference |Location Description

1 System Overview |Displays the overview of the system.
tab

2 Connection Displays the statistics of the traffic through
Dashboard tab the SSLSM.

3 Certificate Displays the information on the certificates.
Dashboard tab

4 Service Dashboard |Displays the information on the PKI
tab service, proxy service, policies, and

VLAN:S.

The System Overview Dashboard displays the following information:

Field Description
Hostname The hostname of the SSLSM.
Software Version The application image version.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Field Description

System Up Time The time elapsed since the SSL module
was started.

Utilization (5 mins) System utilization during the last 5
minutes.

The following utilization information
is available:

e JOS CPU—The average utilization
of the System CPU.

e TCP CPU—The average
utilization of the System CPU.

e SSL CPU—The average
utilization of the System CPU.

e FDU CPU—The average
utilization of the System CPU.

¢ NVRAM-—NVRAM utilization — [
NVRAM size in use / NVRAM
size]

Note  The utilization values are not
updated in real time. You need
to refresh the application to
update the utilization.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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The Certificate Dashboard displays the following information:

Certificate Expiry Dashboard

Number of certificates expiring in the
near future. The expiry count will be
displayed at weekly granularity.

This Week

Number of certificates that will expire
this week.

Next Week

Number of certificates that will expire
next week.

Week 3

Number of certificates that will expire
the week after next.

Week 4

Number of certificates that will expire
in the fourth week from now.

CA Certificates

Valid Certificates

The number of valid CA certificates.

Expired Certificates

The number of invalid CA certificates.

SSL Certificates

Valid Certificates

The number of valid SSL certificates.

Expired Certificates

The number of invalid SSL certificates.

The Connection Dashboard displays the following information:

Statistics The statistics are not updated in real
time. You can view and update the
statistics in Setup > Statistics.

TCP

Connections in ESTABLISHED state

Number of TCP connections in
connections Established state.

Connections in TIME-WAIT state

Number of TCP connections in
connections Time-Wait state.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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SSL

Active Sessions

The number of SSL sessions with
active connections.

The value is rendered as horizontal bar
charts.

Active Connections

The number of SSL connections in
data, handshake and re-negotiation
phase.

The value is rendered as horizontal bar
charts.

Average Connection Rate (past 5 mins)

The rate at which successful
connections were setup in the past 5
minutes.

Handshake Failures (past 5 mins)

Total handshake failures in the past 5
minutes.

The Service Dashboard displays the following information:

PKI

Complete Certificate Chains

Number of complete certificate chains.

A % icon indicates that the certificate
chain is complete.

Incomplete Certificate Chains

Number of incomplete certificate
chains.

A ﬁ icon indicates that the certificate
chain is incomplete.

Proxy Services

Proxy Services Up

Total Proxy Services that are
operational.

A - icon indicates that the module is
operationally up.

| oL-6014-02
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Proxy Services Down Proxy services not operational due to
fault conditions: invalid certificate,
lack of server connectivity, and so
forth, and those that are
administratively down.

AN icon indicates that the module is
administratively and operationally
down.

In Setup > Proxy Services dialog box,
the administratively down status and
operationally down status is indicated
using different icons.

Policies

SSL Policies Number of SSL policies configured on
the module.

TCP Policies Number of TCP policies configured on
the module.

URL Rewrite Policies Number of URL rewrite policies
configured on the module.

HTTP Header Insertion Policies Number of HTTP Header Insertion
policies configured on the module.

VLANs

Total VLANSs Number of VLANSs on the module.

Admin VLAN The admin VLAN ID.

Admin IP Address IP Address of the admin VLAN.

Admin Gateway IP Address of the gateway configured

for the admin VLAN.

All group objects contains a hyperlink. Click on the links to view the details for a
group object.

FAQ

You can find answers for your questions on important tasks using FAQ. Select a
question from the FAQ list, then click Go.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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What Does the Setup Page Show Me?

The Setup page allows you to access the CVDM-SSLSM features. You can launch
wizards from this page or you can start using the PKI, Proxy Service, Policy and

VLAN features.

When you reach the Setup page, the following GUI elements appear in a pane on

the left side of the content window:

GUI Element Description

Wizards Click to launch wizards that will guide
you to in creating and managing
Trustpoints and proxy services.

PKI Allows you to manage public key

infrastructure on the SSLSM.

Proxy Services

Allows you to manage SSL proxy
services on the SSLSM.

Policies Allows you to manage the policy
templates on the SSLSM.

VLANSs Allows you to manage VLAN
configurations on the SSLSM.

Statistics Allows you to view the SSLSM

statistics.

| oL-6014-02
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Selector

Figure 1-3 shows the selector; Table 1-4 describes the selector elements.

Figure 1-3
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Table 1-4 Selector Elements

What Does the Setup Page Show Me?

Figure 1-3

Reference Location

Description

1 Object Grouper You can group the objects using various
parameters. Select your option from the list.

2 Selector handle Click the handle to open and close the
selector, or click the handle and drag it to
resize it.

3 Group folder Displays a group of objects. Click the plus
(+) symbol to see the contents of this folder.

4 Subgroup folder Displays a subgroup of objects. Click the
plus (+) symbol to see the contents of this
folder.

5 Object Displays the individual entity contained in

the group or subgroup. Click an object to
open the page for that object.

Figure 1-3 shows what the selector looks like when folders, subfolders, and
objects are displayed. Not all selectors contain all of these elements.
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Understanding the Action Buttons

This section describes the action buttons that appear in the CVDM-SSLSM dialog

boxes and wizards.

e For a description of the wizard action buttons, see Table 1-5 on page 1-20.

e For adescription of the dialog box action buttons, see Table 1-6 on page 1-20.

Table 1-5

Wizard Action Buttons

Button

Action

Back

Takes you to the previous page.

Next

Takes you to the next page.

Finish

Takes you to the wizard summary page.

Cancel

Exits the wizard without making any
changes.

Help

Displays context-sensitive online help.

Table 1-6

Dialog Box Action Buttons

Button

Action

OK

Saves your changes.

Cancel

Exits the dialog box without making
any changes.

Help

Displays context-sensitive online help.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Editing the Preferences

Step 1
Step 2

Editing the Preferences W

Select Edit > Preferences... The Preferences dialog box appears.

Modify the appropriate values:

GUI Element

Action/Description

Show CLI Preview for
Wizards check box

Select this checkbox if you want CVDM-SSLSM
to display the CLI commands to be delivered to the
device after you have completed a wizard.

When this select this checkbox and click Finish in
a wizard, the Deliver Configuration to the SSLSM
dialog box opens and displays the CLI commands.
For more information, see “Delivering CLI
Commands to the Device” section on page 1-22.

Show CLI Preview on
Delivery check box

Select this checkbox if you want CVDM-SSLSM
to display the CLI commands to be delivered to the
device.

When this select the checkbox and click Deliver,
the Deliver Configuration to SSLSM dialog box
opens and displays the CLI commands. For more
information, see “Delivering CLI Commands to
the Device” section on page 1-22.

Confirm before Exiting
check box

Select this checkbox if you want CVDM-SSLSM
to confirm with you before exiting the application.

Select the Always display this dialog box before
exiting checkbox if you always want
CVDM-SSLSM to confirm that you want to exit
the application.

Refresh after Delivery
check box

Select this check box to refresh CVM after
delivering accumulated CLI commands for the
device.

| oL-6014-02
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Viewing Running Configuration

Step 1

Step 2

Select View > Running Config > SSLSM.... The Running Configuration for
SSLSM dialog box appears. Information about the running configuration for the
SSL Services Module is displayed.

Click Save to File... to save the configuration information to a text file.

Delivering CLI Commands to the Device

Step 1

Note

Note

Step 2

You must deliver accumulated CLI commands to the device before any changes
you make in CVDM-SSLSM will be applied.

Click the Deliver button at the top of the page. The Deliver Configuration to
SSLSM dialog box appears if you have configured CVDM- SSLSM to display the
accumulated CLI commands when you click the Deliver button.

The Deliver Configuration to SSLSM dialog box also appears

when you click the Finish button in a wizard if you have configured
CVDM-SSLSM to display the accumulated CLI commands after you have
completed a wizard.

For Certificate Import and Export Wizards, Deliver CLI Commands dialog box
will not appear.

Modify the appropriate values:

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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GUI Element

Action/Description

Save to Startup checkbox

Click the checkbox to save the running
configuration, generated by CVDM, as the device
startup configuration.

Deliver button

Click to send the accumulated CLI commands to the
device.

Save to File... button

Click to save the CLI commands as a text file.

Close button’

Close the dialog box without delivering any CLI
commands.

Deliver Later button?

Click to deliver the wizard CLI commands to the
device at a later time.

1. This button is available only in the Deliver Configuration to SSLSM dialog box that is displayed
after you click Deliver at the top of the window.

2. This button is available only in the Deliver Configuration to SSLSM dialog box that is displayed
after you click Finish in a wizard.

For Certificate Wizards, Deliver Later option will be disabled. The task will be
performed immediately at the end of the wizard.

The Deliver Configuration to Switch/Module(s) dialog box displays all
accumulated CLI commands that will be delivered to the device; therefore, any
previous CLI commands that were not sent to the device are shown in this dialog
box, as well as the CLI commands you have generated in this session.

| oL-6014-02

User Guide for CiscoView Device Manager for the Cisco SSL Services Module g



Chapter 1  Getting Started with CUDM-SSLSM |

Hl  What's Next?

What's Next?

You are about to set up an SSL Service. To set up the SSL service, first set up the
Public Key Infrastructure. You need to configure Trustpoints and install the Key
Pairs, Proxy Service Certificates, and the corresponding CA Certificates. You can
use the Trustpoint wizards to setup the PKI.

Once the Proxy Service Certificates and Key Pairs are installed in the SSLSM
PKI, the next task in setting up the SSL service is to configure Proxy Services.
You can use the Proxy Service Wizard to setup up the SSL service to configure
proxy service.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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PKI Overview

The following topics provide an overview of the public-key infrastructure (PKI):
e Public Key Infrastructure, page 2-1
¢ Configuring Keys and Certificates, page 2-2

Public Key Infrastructure

PKI is a system that manages encryption keys and identity information for the
human and mechanical components of a network that participate in secured
communications.

The SSL Services Module uses the SSL protocol to enable secure transactions of
data through privacy, authentication, and data integrity; the protocol relies upon
certificates, public keys, and private keys.

The certificates, which are issued by certification authorities and are similar to
digital ID cards, verify the identity of the server to the clients and the clients to
the server. The certificates include the name of the entity to which the certificate
was issued, the entity’s public key, and the time stamp that indicates the
certificate’s expiration date.

Public and private keys are the ciphers that are used to encrypt and decrypt
information. The public key is shared without any restrictions, but the private key
is never shared. Each public-private key pair works together; data that is
encrypted with the public key can only be decrypted with the corresponding
private key.

| oL-6014-02
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Configuring Keys and Certificates

You can configure keys and certificates using one of the following methods:

e If you are using Simple Certificate Enrollment Protocol (SCEP), configure
the keys and certificates by doing the following:

1. Generate a key pair.
Declare the trustpoint.

Get the certificate authority certificate.

& w D

Send an enrollment request to a certificate authority on behalf of the SSL
Server.

See the “Understanding Wizards” section on page 3-10 for details.

e If you are not using SCEP, configure the keys and certificates using the
manual certificate enrollment (TFTP and cut-and-paste) feature by doing the
following:

1. Generate or import a key pair.
2. Declare the trustpoint.

3. Get the certificate authority certificate and enroll the trustpoint using
TFTP or cut-and-paste to create a PKCS10 file.

4. Request the SSL server certificate offline using the PKCS10 package.
5. Import the SSL server certificate using TFTP or cut-and-paste.
See the “Understanding Wizards” section on page 3-10 for details.
e If you are using an external PKI system, do the following:
1. Generate PKCS12 or privacy enhanced mail (PEM) files.
2. Import this file to the module.
See the “Understanding Wizards” section on page 3-10 for details.

An external PKI system is a server or a PKI administration system that generates
key pairs and enrolls for certificates from a certificate authority or a key and
certificate archival system. The Public-Key Cryptography Standards (PKCS)
specify the transfer syntax for personal identity information, including the private
keys and certificates. This information is packaged into an encrypted file. To open
the encrypted file, you must know a pass phrase. The encryption key is derived
from the pass phrase.
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A Trustpoint is an association of a CA Certificate, an RSA Key pair, and the
corresponding SSL Client and Server Certificate.

The following topics are described in this section:

Getting started with Wizards, page 3-2
Understanding Wizards, page 3-10
Importing and Exporting Certificates, page 3-26

Exporting Certificates in Bulk Using the Certificate Export Wizard,
page 3-44

Viewing Certificate Trustpoints, page 3-54
Certificate Trustpoint Details, page 3-58
Editing Trustpoint Configuration, page 3-68
Deleting Certificates, page 3-74

Certificate Hierarchy, page 3-73

How Do I..., page 3-75
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Getting started with Wizards

The details below help you navigate as per the menu.

For more information on Wizards, see Understanding Wizards, page 3-10

Certificate Wizards

The certificate wizards helps you to configure a certificate trustpoint using a
wizard, Importing certificates and private keys, and export certificates and private
keys.

Configuring a Certificate Trustpoint Using the Wizard

This wizard helps you to configure a certificate Trustpoint, generate the
Certificate Signing Request (CSR), and install the SSL certificate obtained using
the CSR.

The wizard also helps you to configure certificate authority (CA) Trustpoints and
install a CA certificate or a CA certificate chain.

N

Note  If the CA issuing your certificate is a subordinate CA, then you must first install
all of the CA certificates in the certification path.

Importing CA Certificate or CA certificate chain

Step1  Configure a trustpoint name. For details, see Configuring a Trustpoint and RSA
Key Pair, page 3-15

Step2  Specify a CA certificate source. For details, see Selecting a CA Certificate
Source, page 3-19

Step3  Specify a CA certificate. For details, see
e Importing a CA Certificate Chain using Copy and Paste, page 3-22
e Importing a CA Certificate Chain from a TFTP Server, page 3-23
e Importing a CA Certificate Chain from a Local Hard Disk, page 3-21
e Specifying a CA Certificate (PEM), page 3-37

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Step 4

Getting started with Wizards

Select Trustpoint setup tasks. For details, see
¢ Configuring Trustpoint Tasks, page 3-24
e Viewing Wizard Summary, page 3-24
e Delivering CLI Commands to the Device, page 1-22
e Viewing Trustpoint Configuration Status, page 3-25

Generating Certificate Signing Request (CSR)

Step 1

Step 2

Step 3

Step 4

Step 5

Configure Trustpoints and RSA key pair. For details, see Configuring a Trustpoint
and RSA Key Pair, page 3-15

Configure SSL certificate attributes. For details, see

e Configuring SSL Certificate Attributes, page 3-16
Configure enrollment parameters. For details, see

¢ Configuring Enrollment Parameters, page 3-17
Specify a CA certificate (for the copy-paste method only). For details, see

e Specifying a CA Certificate (PEM), page 3-37
Select Trustpoint setup tasks. For details, see

¢ Configuring Trustpoint Tasks, page 3-24

e Viewing Wizard Summary, page 3-24

e Delivering CLI Commands to the Device, page 1-22

e Viewing Certificate Signing Request (CSR), page 3-25

Importing the SSL certificate

For more details, see How do I import the SSL certificate obtained using CSR?,
page 3-81.
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Import Certificates and Private Key

This wizard lets you to import certificates and private key to SSLSM from an
external public key infrastructure (PKI). You can import certificates in X.509
PEM, X.509 DER, PKCS#7, or PKCS#12 format. The instructions below guides
you through the steps based on the format and source of the certificates.

Importing CA Certificate, SSL Certificate and Private Key.

Step 1

Step 2

Step 1

Step 2

Step 3
Step 4

To launch the task, see Importing Certificates from an External PKI System,
page 3-26

Importing in PEM format- Local Hard Disk

Specify certificate formats and source. For details, see Configuring Certificate
Source and Format, page 3-28

Specify certificates and private key files. For details, see
e Configuring Certificates and Key Files (PEM - Local Hard Disk), page 3-35
e Viewing the Summary, page 3-37
e Viewing the Certificate Import Status, page 3-38

Importing in PEM format- Copy-and-paste

Specify certificate formats and source. For details, see Configuring Certificate
Source and Format, page 3-28

Specify CA certificate. For more details, see Specifying a CA Certificate (PEM),
page 3-37.

Specify Private Key Specifying Private Key (PEM Format), page 3-37.
Specify SSL certificate. For more details, see:

e Specifying SSL Certificate (PEM Format), page 3-37
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Step 1

Step 2

Getting started with Wizards

e Viewing the Summary, page 3-37

e Viewing the Certificate Import Status, page 3-38

Importing in PEM format- Remote system

Specify certificate formats and source. For details, see
e Configuring Certificate Source and Format, page 3-28
Specify certificates and private key files.
e Configuring Certificates and Key Files (PEM - Remote System), page 3-36
e Viewing the Summary, page 3-37
e Viewing the Certificate Import Status, page 3-38

Importing in DER, PKCS#12, or PKCS#7

See the following sections:
e Configuring Certificate Source and Format, page 3-28
e Viewing the Summary, page 3-37

e Viewing the Certificate Import Status, page 3-38

Importing CA Certificate chain, SSL Certificate and Private Key

Step 1

Step 2

To launch the task, see Importing Certificates from an External PKI System,
page 3-26

Importing in PEM - Local Hard Disk

Specify certificate format and source. For details, see Configuring Certificate
Source and Format, page 3-28

Specify certificates and private key files. For details, see

e Specifying Certificates and Private Key, page 3-32
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Step 1

Step 2
Step 3

Step 4

e Viewing the Summary, page 3-37
e Viewing the Certificate Import Status, page 3-38

Importing in PEM- Copy- and- paste

Specify certificate format and source. For details, see Configuring Certificate
Source and Format, page 3-28

Specify the CA certificates. For details, see Specifying CA Certificates, page 3-34

Specify private key. For details, see Specifying Private Key (PEM Format),
page 3-37

Specify the SSL certificate. For details, see:
e Specifying SSL Certificate (PEM Format), page 3-37
e Viewing the Summary, page 3-37
e Viewing the Certificate Import Status, page 3-38

Importing in PKCS#12, or PKCS#7

See the following sections:
e Configuring Certificate Source and Format, page 3-28
e Viewing the Summary, page 3-37
e Viewing the Certificate Import Status, page 3-38

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module

oL-6014-02 |



| Chapter3

Managing Certificates

Getting started with Wizards

Export Certificates and Private Keys

Step 1
Step 2

Step 3

Step 1

Step 2

Step 3

This wizard lets you to export certificates and private keys from the SSLSM in
PKCS#12 or PEM format. You can export certificates and private keys to an
external system (local hard disk or remote server) or to another SSLSM. When
exporting the certificates in PEM format, you can optionally choose to export the
CA certificates in the certificate chain.

The instructions below guides you through the steps based on the format and
source of the certificates.

To launch the task, do the following:

Click Setup in the CVDM-SSLSM task bar. The Setup page appears

Click Wizards in the left-most pane. The Setup Wizards information appears in
the content area.

Select Export Certificates and Private Keys, then click Launch the Selected
Task. The Certificate Export Wizard appears.

Exporting in PEM format- Local Hard Disk

Select the certificates and format. For details, see Selecting Certificates and
Format (PEM, PKCS#12), page 3-45.

Select a destination. For details, see Specifying the Destination (PEM),
page 3-47.

Specify the destination details. For details, see:
e Specify Destination Details (PEM - Local Hard Disk), page 3-48
e Viewing Certificate Export Wizard Summary, page 3-43
e Viewing the Certificate Export Status, page 3-43
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Exporting using Copy and Paste method

Step 1 Select the certificates and format. For details, see

e Selecting Certificates and Format (PEM, PKCS#12), page 3-45
Step2  Select a destination. For details, see

e Specifying the Destination (PEM), page 3-47

e Viewing Certificate Export Wizard Summary, page 3-43

e Viewing the Certificate Export Status, page 3-43

Exporting to Remote system

Step 1 Select the certificates and format. For details, see Selecting Certificates and
Format (PEM, PKCS#12), page 3-45.

Step2  Select a destination. For details, see Specifying the Destination (PEM),
page 3-47.

Step3  Specify the destination details. For details, see
e Specify Destination Details (PEM - Remote System), page 3-49
e Viewing Certificate Export Wizard Summary, page 3-43
e Viewing the Certificate Export Status, page 3-43

Exporting to Redundant SSLSM

Step 1 Select the certificates and format. For details, see Selecting Certificates and
Format (PEM, PKCS#12), page 3-45.

Step2  Select a destination. For details, see Specifying the Destination (PEM),
page 3-47.

Step3  Specify the destination details. For details, see
e Specify Destination Details (PEM - Redundant SSLSM), page 3-50
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e Viewing Certificate Export Wizard Summary, page 3-43
e Viewing the Certificate Export Status, page 3-43

PKCS#12
Step 1 Select the certificates and format. For details, see Selecting Certificates and
Format (PEM, PKCS#12), page 3-45.
Step2  Select a destination. For details, see Specifying the Destination (PKCS#12),
page 3-51.
Exporting to Remote system
Step 1 Select the certificates and format. For details, see Selecting Certificates and
Format (PEM, PKCS#12), page 3-45.
Step2  Select a destination. For details, see Specifying the Destination (PKCS#12),
page 3-51.
Step3  Specify the destination details. For details, see
e Specify Destination Details (PKCS#12 - Remote System), page 3-51
e Viewing Certificate Export Wizard Summary, page 3-43
e Viewing the Certificate Export Status, page 3-43
Exporting to Redundant SSLSM
Step 1 Select the certificates and format. For details, see Selecting Certificates and
Format (PEM, PKCS#12), page 3-45.
Step2  Select a destination. For details, see Specifying the Destination (PKCS#12),
page 3-51.
Step3  Specify the destination details. For details, see
e Specify Destination Details (PKCS#12 - Redundant SSLSM), page 3-52
User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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e Viewing Certificate Export Wizard Summary, page 3-43
e Viewing the Certificate Export Status, page 3-43

Understanding Wizards

Wizards helps you to configure keys, certificates, and proxy services. You can
access Certificate Wizards and Proxy Service Wizards from this page.

Figure 3-1 Wizards page

& CiscoView Device Manager for 55L5M - 10.77.241.11
File Edit Wiew Help
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Authority

Ifthe CA issuing your cerificates is a subordinate CA, you must first install all
of the CA cerificates in the certification path.

" Import Certificates and Private Key

Import S50 cerificate, issuer CA cerificate, and private key to SSLSM from an
external public-key infrastructure (PRI system.

" Export Certificates and Private Keys

Export S5L certificates and private keys from SSLSM.
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The following topics are included in this section:
Certificate Wizards

The Certificate Wizards helps you to configure keys and certificates. You can
either create certificates and enroll them to the CA or import the certificates and
the associated keys from an external PKI system. You can export the certificates
and private keys using wizards.

e Configuring a Certificate Trustpoint Using the Wizard, page 3-12
e Importing Certificates from an External PKI System, page 3-26
e Exporting Certificates Using the Wizard, page 3-38

e Exporting Certificates in Bulk Using the Certificate Export Wizard,
page 3-44

Proxy Service Wizards

The Certificate Wizards helps you to configure Proxy Services.
e Basic Proxy Service Wizard, page 7-3
e Advanced Proxy Service Wizard, page 7-8

Launching Certificate Wizards

Step 1
Step 2
Step 3

Step 4

To launch certificate wizards, do one of the following:

Click Setup in the task bar. The Setup page appears.
Click Wizard in the left-most pane. The Wizards information page appears.
Click the Certificate Wizards tab to create a CertificateTrustpoint.
You can select either of the following tasks:
— Configure Certificate Trustpoint
— Import Certificates and Private Key.
— Export Certificates and Private Key.

Select one of the tasks, then click Launch the Selected Task. The Trustpoint
Setup wizard appears with information on the steps to follow.
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Step 1

Step 2

Or:

Click Setup at the top of the window, click PKI in the left-most pane, and select
Certificate Trustpoints from the object Selector.

Click the Setup Wizard and select either of the following wizards:
— Configure Certificate Trustpoint
— Import Certificates and Private Key.

- Export Certificates and Private Key.

Configuring a Certificate Trustpoint Using the Wizard

Step 1
Step 2
Step 3
Step 4

You can use the wizard to configure a certificate Trustpoint, authenticate, and
enroll with a CA using the wizard.

To configure a certificate trustpoint:

Click Setup in the task bar. The Setup page appears.
Click Wizards in the left-most pane. The Wizards information page appears.
Click the Certificate Wizards. The Certificate Wizards page appears.

Select Configure Certificate Trustpoint, then click Launch the Selected Task.
The Trustpoint Configuration dialog box appears. The dialog box provides
information on the steps to be followed to configure a Trustpoint.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Understanding Wizards

You can use the wizard to configure either of the following Trustpoints:
e Proxy Service Trustpoint.
e CA Trustpoint.

Click Next to continue.

Setting up a Proxy Service Trustpoint

Step 1
Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8

Step 9

You can use any one of the following options to set up a proxy service trustpoint:
e Create a new proxy service Trustpoint.
e Configure a proxy service Trustpoint using the copy-and-paste method.

To create a new Proxy Service Trustpoint:

Click Setup in the task bar. The Setup page appears.

Click Wizard in the left-most pane. The Wizards information page appears.
Click the Proxy Service Wizards tab to create a proxy service Trustpoint.
Configure Trustpoint name and RSA key pair.

(Optional) Configure SSL certificate attributes, then click Next.

Configure enrollment parameters, then click Next.

Select Trustpoint setup tasks, then click Next. The summary dialog box appears.

Click Finish. The Deliver Configuration to SSLSM dialog box appears with the
details on the CLI commands to be delivered to the module.

Click Deliver to deliver the CLI commands. The Trustpoint Configuration Status
dialog box appears.

| oL-6014-02
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To configure a Proxy Service Trustpoint using the copy-and-paste method:

Step1  Configure Trustpoint name and RSA key pair.

Step2  (Optional) Configure SSL certificate attributes, then click Next.

Step3  Configure enrollment parameters, then click Next.

Step4  Specify CA certificate, then click Next.

Step5  Select Trustpoint setup tasks, then click Next. Summary dialog box appears.
Step6  Click Finish.

Setting up a CA Trustpoint

To configure a CA Trustpoint:
Step1  Configure Trustpoint Name.
Step2  Specify CA Certificate source.
To configure a CA Trustpoint using the copy-and-paste method:

Step1  Configure Trustpoint Name.
Step2  Specify CA Certificate source.
Step3  Specify CA Certificate.
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Configuring a Trustpoint and RSA Key Pair

Note

The Configure Trustpoint and RSA Key Pair page helps you set up a proxy service
Trustpoint or a CA Trustpoint. You can either use an existing key pair for the

Trustpoint or generate a new key pair.

If you are creating the Trustpoint for the first time, generate a new key pair. You
will not be able to use an existing key pair.

The following fields appear:

Field

Action/Description

Trustpoint Name

You can add a new trustpoint or select
an existing Truspoint.

Trustpoint Type

Proxy Service Trustpoint

Select this option to create a proxy
service Trustpoint, generate CSR and,
install the enrolled SSL certificate.

CA Trustpoint

Select this option to install a CA
certificate or a CA certificate chain.

RSA Key Pair

Generate a new Key Pair

Select this option to generate a new key
pair.

Key Pair Name

Enter the name of the key pair.

We recommend that you use a key pair
name that matches the trustpoint name.

Key Size

The size of the key.

Key size can be 512, 768, 1024, 1536,
or 2048

Allow Private Key Export

Select this option to make the new key
exportable.

You need to select this to export the
key at a later point of time.
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Field

Action/Description

Use an Existing Key Pair

Select this option to use an existing key
pair.

Key Pair Name

Select the key pair name.

Configuring SSL Certificate Attributes

The SSL Certificate Attributes wizard page allows you to enter the SSL certificate
attributes for the certificate Trustpoint. Even though it is not mandatory to fill any
of these fields, we recommend you to fill the common name (CN) field.

The following fields appear on the SSL certificate attributes dialog box:

Field

Description

Subject Distinguished Name (DN)

The fully qualified domain name in the
certificate.

The subject name uses Lightweight
Directory Access Protocol (LDAP)
format.

Common Name (CN)

The common name to be used.

Example: server.domain.com, where
server is the name of the SSL
server that appears in the URL.

Email Address (EA)

E-mail address.

Organization Unit (OU)

Organization Unit.

Example: Cisco

Department (D)

Name of the department.

Example:Lab

Location (L)

The location of the organization.

Example, San Jose

State (ST)

The name of the state.

Example, California

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Field Description

Country (C) The country name.

Example: US

Include SSLSM Serial Number Select this option to include the serial
number of the SSLSM module in the
certificate.

Unstructured

Unstructured Name The unstructured URL of the server.

Example: server5.domain.com

Subject IP Address IP address to be included in the
certificate.

Other

Certificate Purpose Select between the options SSL Client

and SSL Server.

Configuring Enroliment Parameters

The Configure Enrollment Parameters page of the wizard allows you to specify
the enrollment parameters for your certificate authority.

The following field appears in the configure enrollment parameters page:

Field Description

CA The name of the certificate authority.

e If you are configuring enrollment
parameters for a new CA, choose
the field display as <NEW>.

e If you want to enroll with a CA
already configured, select the CA
from the list and modify the
parameters.

Simple Certificate Enrollment Select this to use the SCEP.
Protocol (SCEP)

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Field

Description

CA Server URL

URL of the CA server.

Challenge Password

Enter a Challenge Password.

Confirm the Password

Confirm the challenge password.

Retry Count

Number of retries.

Enable Auto-Enrollment

Select to enable auto-enrollment.

Retry Period (Minutes)

Time to wait for the next retry.

HTTP Proxy URL of the HTTP proxy to be used for
the enrollment.

Port The port to be used for the enrollment.

TFTP Select this if you are using TFTP.

CA Server URL

URL of the CA server.

Example:
tftp://ipaddress/Certificates/filename

The suffix.ca is appended to the file
name.

Copy and Paste / Local Hard Disk

Select this option to Copy-and-Paste
the Certificate or specify Certificate
from the local Hard Disk.

The TFTP and cut-and-paste feature allows you to generate a certificate request
and accept certification authority certificates as well as router certificates. These
tasks are accomplished with a TFTP server or manual cut-and-past operations.

You may want to use TFTP or manual cut-and-paste enrollment in the following

situations:

* Your certificate authority does not support Simple Certificate Enrollment

Protocol (SCEP).

e A network connection between the router and certificate authority is not
possible. The router running Cisco IOS software obtains its certificates using
a network connection between the router and the certificate authority.
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Selecting a CA Certificate Source

Note

The CA Certificate Source page of the wizard allows you to specify the source of
the CA certificate. You can import a CA certificate or a CA certificate chain. You
can import a certificate chain using X.509 PEM or PKCS#7 format.You can select
any of the following formats:

e X.509 PEM
e X.509 DER
e PKCS#7

To import the certificate using SCEP, select the PKCS#7 format.

If you have selected X.509PEM, the following options appear:

¢ Local Hard Disk—Select this option to import the CA certificate from the
client machine.

¢ Copy and Paste—Select this option to import the CA certificate using copy
and paste method.

e TFTP—Select this option to import the CA certificate from a TFTP server.

e Select the Import a CA Certificate Chain check box to import the certificate
chain.

If you have selected X.509 DER, you need to select the CA Certificate File. Click
Browse and browse to the directory where you have the certificate file, then select
the file.

If you have selected PKCS#7, the following fields appear:

Field Description

Simple Certificate Enrollment Select this option to import file using

Protocol (SCEP) SCEP.

CA Server URL Enter the URL of the CA Server.

Local Hard Disk Select this option to import a file from
the local hard disk.
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Field Description
PKCS#7 File Click Browse and browse to the
directory where you have the PKCS#7
file, then select the file.
PKCS#7 CA Certificates
CRL Verification Options are:
e Strict (Default)
e Optional
e Best Effort
CA Level Level of CA in the certificate chain.
CA Name Name of the CA.
Trustpoint Name Name of the Trustpoint to which the
CA certificate is imported.

Click Next to continue.

Importing a CA Certificate Chain

You can specify all the certificates in a certificate chain and the wizard will create
CA Trustpoints for each of the CA certificate.

A suffix is added to Trustpoint name based on whether the CA certificate is a root
or sub-ordinate CA certificate. You can edit the default Trustpoint name by using
the CA Trustpoints tab. As the certificates are added, the status of the certificate
and certificate chain is displayed.

To import a CA certificate chain:

Step1  Configure Trustpoint Name.
Step2  Specify CA Certificate source as X.509 PEM.

Step3  Select the source from where you want to import the certificate chain. The options
are: Local Hard Disk, Copy and Paste, TFTP.

Step4  Select Import a CA Certificate Chain check box.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
m. oL-6014-02 |




| Chapter3

Managing Certificates

Understanding Wizards

e If you have selected Local Hard Disk, see Importing a CA Certificate Chain
from a Local Hard Disk, page 3-21.

e If you have selected Copy and Paste, see Importing a CA Certificate Chain
using Copy and Paste, page 3-22.

e If you have selected Local Hard Disk, see Importing a CA Certificate Chain
from a TFTP Server, page 3-23.

Importing a CA Certificate Chain from a Local Hard Disk

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6

Step 1
Step 2

Step 3

Note

Configure Trustpoint Name.
Specify CA Certificate source as X.509 PEM.
Select Local Hard Disk.

Select Import a CA Certificate Chain check box, then click Next. The Specify
CA Certificate page appears.

Specify the CA certificates in the CA Certificate Chain

Click Next to continue.

To specify the certificates in the certificate chain:

Click Add. The Add a Certificate popup window appears.

Click Browse to browse to the directory where you have the certificate file and
select it.

Click OK.

When specifying the certificates in the certificate chain, add Root CA through the
subordinate CA in accordance with the certificate hierarchy.
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Importing a CA Certificate Chain using Copy and Paste

Step 1
Step 2
Step 3
Step 4

Step 5
Step 6

Step 1
Step 2

Step 3

Note

Configure Trustpoint Name.
Specify CA Certificate source as X.509 PEM.
Select Copy and Paste.

Select Import a CA Certificate Chain check box, then click Next. The Specify
CA Certificate page appears.

Specify the CA certificates in the CA Certificate Chain.

Click Next to continue.

To specify the certificates in the certificate chain:

Click Add. The Add a Certificate popup window appears.
Copy and Paste the certificate in PEM format to the Certificate field.

Click Clear to remove the content or click View Details to view the details of the
certificate.

Click OK to add the certificate.

When specifying the certificates in the certificate chain, add Root CA through the
subordinate CA in accordance with the certificate hierarchy.
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Importing a CA Certificate Chain from a TFTP Server

To import a CA certificate chain from a TFTP server:

Step1  Configure Trustpoint Name.
Step2  Specify CA Certificate source as X.509 PEM.
Step3  Select TFTP.

Step4  Select Import a CA Certificate Chain check box, then click Next. The Specify
CA Certificate page appears.

Specify the CA certificate in the certificate chain. You must specify all
certificates in the chain from root CA.

The following fields appear:

Field Description

CA Level Level of CA in the certificate chain.

CA Certificate File URL (TFTP) of the CA certificate.

Trustpoint Name Name of the Trustpoint to which the
CA certificate is imported.

You can add certificates to the list. To add a CA certificate:

Step 1 Click Add. The Add a Certificate popup window appears.
Step2  Enter the TFTP Server IP address.

Step3  Enter the file name. The certificate file name must have a.ca extension.

Note  The validity of the certificate or the completeness of the certificate chain is not
validated. Please make sure that you specify valid CA certificates and all the
certificates are in the certificate chain.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Note = When specifying the certificates in the certificate chain, add Root CA through the
subordinate CA in accordance with the certificate hierarchy.

Configuring Trustpoint Tasks

The Trustpoint Setup Tasks wizard page allows you to select a Trustpoint
configuration task that you want to perform on the certificate Trustpoint.

You can select one of the following tasks:

Field

Action/Description

Generate CS R (Enroll)

Select this option to apply the
trustpoint configuration, authenticate
the CA certificate, and generate
certificate request (enroll).

Authenticate the CA Certificate

Select this option to apply the
trustpoint configuration and
authenticate the CA certificate

Import SSL Server Certificate

Select this option to apply the
Trustpoint configuration and import
the SSL certificate. This is applicable
only to manual enrollment methods.

Viewing Wizard Summary

When you use a wizard to perform a configuration, the wizard's Summary page
displays the values that you have configured. You can examine those values and
click the wizard's Back button to return to a screen on which you need to make a
change. When you have made the changes, click the Finish button to save your

changes and leave the wizard.
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Delivering Configuration to an SSL Module

This page provides information on the CLI commands you have configured.
Click Deliver to deliver the commands to the module

Click Save to File to save the commands to a file.

Click Deliver Later to deliver the commands at a later point of time.

For more information on delivering CLI commands, see Delivering CLI
Commands to the Device, page 1-22

Viewing Trustpoint Configuration Status

The Trustpoint Configuration Status dialog box provides the status details of the
Trustpoint configuration tasks. The details displayed vary according to the task
you selected. The dialog box displays the status against each task. The
configuration performed on the module is displayed in the content area. If any
task fails, you can review the task details and take necessary action.

Click OK to view the Certificate Signing Request (CSR). For more information
on Certificate Signing Request (CSR), see Viewing Certificate Signing Request
(CSR), page 3-25

For authentication, after displaying the status, the finger print information
appears. Verify the finger print displayed and accept the certificate to complete
the authentication.

Viewing Certificate Signing Request (CSR)

The Certificate Request dialog box provides information on the certificate
requested.

Click Save to File to save the certificate request. The file is saved with the default
extension.csr.

Click Cancel to close the dialog box.
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Importing and Exporting Certificates

You can use wizards to import and export certificates. This section contains the
following information:

e Importing Certificates from an External PKI System, page 3-26
e Exporting Certificates Using the Wizard, page 3-38

e Exporting Certificates in Bulk Using the Certificate Export Wizard,
page 3-44

Importing Certificates from an External PKI System

The Certificate Wizard allows you to import Certificates and Private Keys from
an external PKI. You can import certificates in X.509 PEM, X.509 DER,
PKCS#7, or PKCS#12 format.

To import certificates using Trustpoint Wizard:

Step1  Click Setup in the CVDM-SSLSM task bar.The Setup page appears
Step2  Click Wizards in the left-most pane. The dialog box appears.

Step3  Select Import Certificates and Private Key, then click Launch the Selected
Task. The Certificate Import Wizard appears.

You can import files in either of the following formats:
e X.509 PEM file, See Importing PEM File, page 3-27.
e PKCS#12 file, See Importing PKCS#12 File, page 3-26.
e X509 DER file
e PKCS#7 file

Importing PKCS#12 File

You can use an external PKI system to generate a PKCS#12 file and then import
this file to the module.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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When creating a PKCS#12 file, include the entire certificate chain, from server
certificate to root certificate, and public and private keys. You can also generate
a PKCS#12 file from the module and export it.

Note  Imported key pairs cannot be exported.

If you are using SSH, we recommend using SCP when importing or exporting a
PKCS#12 file. SCP authenticates the host and encrypts the transfer session.

To import a PKCS#12 File:

Step 1 Enter certificate format and source, then click Next. The Summary dialog box
appears.

Step2  Click Finish to complete importing the certificate.

Importing PEM File

To import a PEM File:

Step 1 Enter the format and source.

Step2  Specify the certificate and key Files.

Step3  Specify the private key.

Step4  Specify SSL certificate.

Step5  Click Next. The summary dialog box appears.
Step6  Click Finish to complete importing the file.

You can copy and paste the CA Certificate in PEM format.
To import a PEM File using the copy-and-paste method:

Step 1 Enter the format and source

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Step 2
Step 3
Step 4

Copy-and-paste the CA Certificate in PEM format.
Click Next. The summary dialog box appears.
Click Finish to complete importing the file.

Configuring Certificate Source and Format

Step 1

Step 2

Step 3

The Certificate Source and Format page of the wizard allows you to enter the
Trustpoint name, format and source.

You can select any of the following formats and select the source of the
certificates and private key:

e X.509 PEM

e PKCS#12

e X.509 DER

e PKCS#7
X.509 PEM

Select one of the following PEM formats:
e Local Hard Disk—to import certificates from the client workstation.

¢ Copy and Paste—to import certificates and key using copy-and-paste
method.

e Remote system—to import certificates from a remote system using TFTP,
FTP, RCP, or SCP.

(Optional) Select Import Certificate Chain to import the certificate chain
associated with the Trustpoint. (This option is available only if you select Local
Hard Disk or Copy and Paste)

Select one of the option, then click Next.
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e If you have selected Local Hard Disk and Import Certificate Chain, the next
step is specifying certificates and key pairs.

e If you have selected Copy and Paste, and Import Certificate Chain, the next

step is specifying CA certificates.

PKCS#12

Select PKCS#12, the following fields will be displayed:

Field Description
Protocol Select any of the following protocols to
be used for importing the file:
e TFTP
e FTP
e RCP
e SCP
IP Address IP address of the certificate source.
User Name User name for the remote system.
Password Password to be used for the remote
system.
PKCS#12 File File name with the absolute path and
the file name.
Example:
d:/tftpboot/certs/cert.pl2
Passphrase Passphrase to be used to decrypt the

key.

Create Trustpoints for CA Certificates
in Certificate Chain

Select this is to create Trustpoints for
certificates higher in the hierarchy.

| oL-6014-02

User Guide for CiscoView Device Manager for the Cisco SSL Services Module g



Chapter3  Managing Certificates |

| Importing and Exporting Certificates

X.509 DER

Field Description

CA Certificate File Click Browse and select the certificate
file from the directory.

Private Key File Click Browse and select the certificate
file from the directory.

Private Key Passphrase Enter the Passphrase for the private
key.

NET Format (Netscape For private key in NET format, you

Server/Microsoft IIS) must specify the RC4 passphrase used
to encrypt the key. The same
passphrase will be used to encrypt the
private key in PEM format.

SGC Key This is active only for NET Format key.

Allow Private Key Export Select the check box to allow exporting
the private keys.

PKCS#7

The wizard will use the following suffixes when creating the CA Trustpoints:
e Root CA Certificate: -rootCA
e Sub-ordinate CA Certificate: -subCA<level>

Field Description

PKCS#7 Certificate File Click Browse and select the certificate
file from the directory.

Create Trustpoints for CA Certificates |Select this option to create Trustpoints
in Certificate Chain for certificates in a chain. On selecting
this check box a new set of field details
appears below.

For details see PKCS#7 CA
Certificates field in the same table.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Field Description

Private Key File (PEM) Click Browse and select the certificate
file from the directory.

Private Key Passphrase Passphrase to be used to decrypt the
key.

Allow Private Key Export Select the check box to allow exporting
the private keys.

PKCS#7 CA Certificates This field appears only if you select
Create Trustpoints for CA certificates
in Certificate Chain option. It provides
the list of CA certificates in the
PKCS#7 file.

CRL Verification You can select any option given below:

e Strict (default)

e Optional

e Best Effort
This selected option applies to the
entire table below.

The table below provides the list of CA certificates in the PKCS#7 file.

CA Level The level of the CA in the certificate
chain.

CA Name The name of the certification authority.

Trustpoint Name The name of the trustpoint associated
with the certificate.

A passphrase protects a PEM file that contains a private key. The PEM file is

encrypted by DES or 3DES.

Enter the details, then click Next.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Specifying Certificates and Private Key

If you have selected to import a certificate chain in X.509 PEM format from the
local hard disk you need to specify the CA certificates, SSL (Server/Client)

certificate and private key.

You must specify all CA certificates in the chain from the root CA to the issuer

of the SSL certificate.

The following fields appear:

Fields

Description

CA Certificate Chain

CRL Verification

Select the level of verification. It can
be one of the following:

e Strict
e Optional
e Best Effort

Chain

Add the certificate in the chain.

Add—Click Add to add a CA
certificate to the chain. A popup dialog
box appears.

Enter the CA Trustpoint Name, The
certificate in PEM format is displayed.

Click View Details to view the details
of the CA Certificate.

Click OK to complete adding the
certificate.

Remove—Select a certificate from the
chain, then click Remove to remove the

CA certificate from the chain.
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Fields Description
CA Trustpoints Provides the details of the CA
Trustpoints.

You can specify the name of the
Trustpoint and can even edit the name
of the Trustpoint.

CA Level—Level of the CA in the
certificate chain.

CA Name—The name of the
certification authority.

Trustpoint Name—Name of the
trustpoint associated with the
certificate.

Select a CA Trustpoint, then click Edit
to edit the CA Trustpoint.

SSL Certificate and Private Key File

SSL Certificate File Click Browse, and navigate to the
folder where you have the SSL
Certificate file.

Private Key File Click Browse, and navigate to the
folder where you have the Private Key
file.

Private Key Passphrase Passphrase to be used to decrypt the

private key.

Allow Private Key Export Select this check box if you want to
allow the private key to be exported.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Specifying CA Certificates

If you have selected to import a certificate chain in X.509 PEM format using the
copy and paste method, you need to specify the CA certificates from the root CA
to the issuer of the SSL certificate. The following fields appear:

Field

Description

CA Certificate Chain

CRL Verification

Select the level of verification. It can be one of the
following:

e Strict
e Optional
e Best Effort

Chain

Displays the certificate chain.

Add—cClick Add to add a CA certificate to the
chain. A popup dialog box appears.

Enter the CA Trustpoint Name, The certificate in
PEM format is displayed.

Click View Details to view the details of the CA
Certificate.

Click OK to complete adding the certificate.

Remove—Select a certificate from the chain, then
click Remove to remove the CA certificate from the
chain.

CA Trustpoints

Provides the details of the CA Trustpoints.
CA Level—Level of the CA in the certificate chain.
CA Name—The name of the certification authority.

Trustpoint Name—Name of the trustpoint
associated with the certificate.

Select a CA Trustpoint, then click Edit to edit the
CA Trustpoint.
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Click Next to continue.

Configuring Certificates and Key Files (PEM - Local Hard Disk)

The Certificates and Key Files dialog box allows you to specify the location of
the certificates and key files.

The following fields are displayed:

Field Description

CA (Certificates Issuer) To create a new CA, specify the CA
(issuer of the SSL certificate)
certificate, private key and SSL
certificate files you want to import. If
the CA certificate is available on the
SSLSM select the corresponding CA
name.

CA Certificate File The CA certificate file name with the
absolute path. You can browse and
select the file from the local hard disk.

Private Key File The private key file name with the
absolute path. You can browse and
select the file from the local hard disk.

Private Key Passphrase The passphrase to decrypt the key.

Allow Private Key Select the check box to allow the
private key export facility.

SSL Certificate File The SSL certificate file name with the
absolute path. You can browse and
select the file from the local hard disk.

Note A passphrase protects a PEM file that contains a private key. The PEM file is
encrypted by DES or 3DES. The encryption key is derived from the pass phrase.
A PEM file containing a certificate is not encrypted and is not protected by the
pass phrase.
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Configuring Certificates and Key Files (PEM - Remote System)

The Certificates and Key Files dialog box allows you to specify the location of

the certificates and key files.

The following fields appear:

Field

Description

Protocol

Select the protocol to be used for
importing the file. You can select any
of the following protocols:

e TFTP
e FTP
e RCP
e SCP

IP Address

IP address of the remote system.

Username

User name for the remote system.

Password

Password for the remote system.

CA Certificate File

The CA certificate file name with the
absolute path.

Enter the absolute path and the file
name.

Example: /Certs/cert.pem

Private Key File

The Private Key file name with the
absolute path.

Enter the absolute path and the file
name.

Example: /Certs/cert.pem

Passphrase

The passphrase to decrypt the key.

SSL Certificate File

The SSL certificate file name with the
absolute path.

Example:
/user/local/Certs/cert.pem
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A passphrase protects a PEM file that contains a private key. The PEM file is
encrypted by DES or 3DES. The encryption key is derived from the pass phrase.
A PEM file containing a certificate is not encrypted and is not protected by the
pass phrase.

Specifying a CA Certificate (PEM)

This page of the wizard allows you to copy-and-paste the CA certificate in PEM
format.

In Certificate Trustpoint Setup Wizard you can browse and specify the CA
certificate file.

In Certificate Import Wizard you can select the CA certificate from the CA
(Certificate Issuer) drop-down list. If you select any of the CA, the certificate
details are displayed.

Click Next to continue.

Specifying Private Key (PEM Format)

Copy and paste the RSA private key in PEM format and enter the passphrase used
to protect the key.

Click Next to continue.

Specifying SSL Certificate (PEM Format)

Copy and paste the SSL Certificate in PEM format.

Click Next to continue.

Viewing the Summary

When you use a wizard to perform a configuration, the wizard's Summary screen
displays the summary of the certificate you are about to import.

You can examine the values and click the Back button to return to a screen on
which you need to make a change. When you have made the changes, click the
Finish button to import the certificate and leave the wizard.

| oL-6014-02
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Delivering Configuration to SSL Module

This page provides information on the CLI commands you have configured.
Click Deliver to deliver the commands to the module

Click Save to File to save the commands to a file.

Click Deliver Later to deliver the commands at a later point of time.

For more information on delivering CLI commands, see Delivering CLI
Commands to the Device, page 1-22

Viewing the Certificate Import Status

The certificate import status dialog box dialog box provides the status details of
the Trustpoint configuration tasks. The details displayed vary according to the
task you selected. The dialog box displays the status against each task.

The configuration performed on the module is displayed in the content area. If any
task fails, you can review the task details and take necessary action.

Exporting Certificates Using the Wizard

You can export certificates using either PKCS#12 file format or
privacy-enhanced mail (PEM) file format.

Exporting certificates of more than one Trustpoint

To export certificates of more than one Trustpoint, see Export Certificates and
Private Keys, page 3-7.

Exporting certificates of a selected Trustpoint

Step1  Click Setup at the top of the window, click PKI in the left-most pane, and select
Trustpoints from the object Selector. The Trustpoint page appears.

Step2  Select a Trustpoint node from the logical group. You can group the Trustpoints
using Trustpoint Grouper.

Step3  Select a Trustpoint from the list.
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Step4  Click Operations, then select Export from the popup menu.
Step5  The Trustpoint Export Wizard appears.
You can export Trustpoints in using PKCS#12 or PEM format.

For more information on exporting Trustpoints in PKCS#12 file format, see
Exporting PEM Files, page 3-40.

For more information on exporting Trustpoints in PKCS#12 file format, see
Exporting PKCS#12 Files, page 3-39.

Exporting PKCS#12 Files

To export a PKCS#12 File:

Step 1 Enter Certificate Format and Destination, the click Next. The summary page
appears.

Step2  Click Finish to compete exporting the file.
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Exporting PEM Files

To export a PEM File:

Step 1 Enter certificate format and destination, the click Next.

You can select any of the following:

e Local Hard Disk—to export certificates and keys to the client workstation.

e Copy-and-Paste—to export certificates and keys using copy-and-paste

method.

e Remote System—to export certificates and keys using TFTP, FTP, RCP or

SCP.

Step2  Specify Certificate and Key files. The fields change depending on the source you

have selected.

Step3  Click Finish to complete exporting the files.

Certificate Format and Destination

The Certificate Format and Destination page of the wizard allows you to specify
the Trustpoint name and then select the format and destination.

The dialog box displays following fields:

Field

Description

Trustpoint Name

The name of the Trustpoint.

Pass phrase

The pass phrase to be used for
decrypting the key.

Encryption

The encryption to be used for the key
pairs.

Format

The file format. Options are PEM and
PKCS#12.

If you select PEM, the following fields appear:
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Field Description

Local Hard Disk Select to export certificates and keys to
the client workstation

Copy and Paste Select to export certificates and keys
through copy-and-paste.

Remote System Select to export certificates and keys
using TFTP, FTP, RCP or SCP.

If you select PKCS#12, the following fields appear:

Field Description

Protocol The protocol used for the transferring
the keys.

IP Address The IP address of the destination
system.

User Name The user name for the destination
system.

Password The password to be used for the
destination system.

PKCS#12 Certificate File Specify the PKCS#12 file format.
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Certificate and Key Pair Files (PEM - Local Hard Disk)

The Certificate and Key Pair Files (PEM Local Hard Disk) page of the wizard
allows you to export PEM files from your local hard disk.

The following fields appear:

Field Description

CA Certificate File Enter the CA Certificate file name with
the absolute path. Alternatively, you
can browse and select the file from the
local hard disk.

Private Key File Enter the Private Key File name with
the absolute path. Alternatively you
can browse and select the file from the
local hard disk.

SSL Certificate File Enter the SSL Certificate File name
with the absolute path. Alternatively
you can browse and select the file from
the local hard disk.

Certificate and Key Pair Files (PEM - Remote File System)
The Certificate and Key Pair File (PEM Remote File System) page of the wizard
allows you to export a PEM file from a remote file system.

This page allows you to protocol, certificate and private key file destination
details.

The following fields appear:

Field Description

Protocol Protocol to be used for exporting the
file.

IP Address IP address of the remote system.

User Name User name for the remote system.

Password Password for the remote system.
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Field

Description

CA Certificate File

The absolute path to the CA Certificate
file.

Example:/certs/cert.pem

Private Key File

The absolute path to the Private Key
file.

Example:/certs/cert.pem

SSL Certificate File

The absolute path to the SSL
Certificate file.

Example:/certs/cert.pem

Viewing Certificate Export Wizard Summary

When you use a wizard to perform a configuration, the wizard's Summary page
displays the values that you have configured. You can examine those values and
click the wizard's Back button to return to a screen on which you need to make a
change. When you have made the changes, click the Finish button to save your

changes and leave the wizard.

Viewing the Certificate Export Status

The certificate export status dialog box dialog box provides the status details of
the certificate export tasks. If the task fails, you can review the task details and

take necessary action.
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Exporting Certificates in Bulk Using the Certificate
Export Wizard

The Certificate Export Wizard allows you to select multiple Certificates and
Private Keys and export them.

To export certificates using Certificate Export Wizard:

Step1  Click Setup in the CVDM-SSLSM task bar.The Setup page appears

Step2  Click Wizards in the left-most pane. The Setup Wizards information appears in
the content area.

Step3  Select Export Certificates and Private Keys, then click Launch the Selected
Task. The Certificate Export Wizard appears.

You can export the certificates in either of the following formats:
e X.509 PEM
e PKCS#12

To export certificates and private keys in X.509 PEM format:

Step 1 Select Certificates and Format (X.509).
Step2  Specify the Destination Details
Step3  View the Status.

To export certificates and private keys in PKCS#12 format:

Step 1 Select Certificates and Format (X.509).
Step2  Select the Destination.
Step3  Specify the Destination details.
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Selecting Certificates and Format (PEM, PKCS#12)

This page of the wizard helps you to specify the certificates to be exported and
the format in which you want them to be exported.

The certificates are listed in the Certificates table. The following fields are
displayed:

Field Description
SSL Certificate Subject The subject of the SSL certificate.
Certificate TrustPoint The Trustpoint name of the certificate.

Select Export CA Certificate in the Chain to export the CA Certificates in the
certificate chain of the selected certificates.

You can add and remove Certificates from the list:

e Click Add to add certificates to the export list. A popup window appears with
the list of Trustpoints and Proxy Services. Select the Trustpoint or proxy
services from the list, then click OK.

e Select a certificate and click Remove to remove a certificate from the export
list.

Select the Format in which you want to export the certificate. You can export the
certificates in X.509 PEM format or PKCS#12 format.

If you have selected X.509 PEM format, specify the following:

Field Description

Encryption The following are the encryption
options:
3DES

Passphrase Enter the passphrase.

Confirm Passphrase Re-enter the passphrase to confirm.

Select the check box against Export CA Certificates in certificate chains to
enable the export of the CA certificates in certificate chains.
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If you have selected PKCS#12, specify the following:

Field Description
Passphrase Enter the passphrase.
Confirm Passphrase Re-enter the passphrase to confirm.

Adding Certificates and Trustpoints for exporting

Step 1
Step 2

Step 3

Step 4

Step 5
Step 6
Step 7

Step 8

Step 9

To add certificates and trustpoints to the export list:

Click Setup in the CVDM-SSLSM task bar.The Setup page appears

Click Wizards in the left-most pane. The Setup Wizards information appears in
the content area.

Select Export Certificates and Private Keys, then click Launch the Selected
Task. The Certificate Export Wizard appears.

Click Add. A popup window appears with the list of Trustpoints and Proxy
Services.

Click the tabs to select Trustpoint or Proxy Services.
Select the Trustpoint or Proxy Service from the list.

If you select Trustpoint, the following fields appear:

Field Description

Trustpoint Name The name of the Trustpoint.
Subject Name The name of the subject.
Issuer Name (CA) The name of the issuer.

Select a Trustpoint Name and click OK to add or click Cancel to close the
window.

If you select Proxy Services, the following fields appear:

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module

oL-6014-02 |



| Chapter3 Managing Certificates

Exporting Certificates in Bulk Using the Certificate Export Wizard W

Field Description

Proxy Service Name The name of the proxy service.
Subject Name The name of the subject.
Issuer name (CA) The name of the issuer.

Step10  Select a Proxy Service Name and click OK to add or click Cancel to close the
window.

Specifying the Destination (PEM)

You can select any one of the following destination for theX.509 Format:

e Local Hard Disk—To export the certificate and private key to this client
machine.

e Copy and Paste—To export the certificates and private key using copy and
paste method.

e Remote System—To export the certificates and private keys to a remote
server using TFTP, FTP, SCP, or RCP.

e Redundant SSLSM—To export the certificates and private keys to a
redundant SSL services module.

>
Note  Copy and Paste and Remote System options will be disabled if you select more
than one certificate.
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Specify Destination Details (PEM - Local Hard Disk)

You can specify the destination details using this page.

The following fields are displayed:

Fields Description

Directory Click the Browse button and browse to
the directory where you want the
certificate to be exported.

Trustpoint Displays the name of the trustpoint.

CA Certificate File Displays the CA certificate chain
names.

SSL Certificate File Displays the SSL certificate chain
names.

Private Key File Displays the Private Key option file
names.

If you have selected the Export CA Certificate in Certificate Chains in the step
1 then the CA Certificates in Certificate Chains table with the following details
are displayed.

Fields Description

Certificate Authority (CA) Name Displays the chain of certificate
authority names.

CA Certificate File Displays the chain of CA certificate
file names.

Click Next to continue.
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Specify Destination Details (Copy and Paste)

This page is enabled only when exporting a single Trustpoint. Once the export is
completed, exported certificates and privates keys are displayed. You can copy
and paste the certificate and save the file.

Specify Destination Details (PEM - Remote System)

Specify the details of the Remote system where you want the certificates and
private keys to be exported.

The following fields are displayed:

Fields Description
File Server
Protocol Select from options:
e FTP
e RCP
e SCP
e TFTP
Server IP Address Enter the IP address of the system.
Username Enter the user name
Password Enter the password.
Files
Directory Enter the path or location of the files.
Trustpoint Displays the name of the Trustpoint.
CA Certificate File Displays the name of the CA
Certificate files.
SSL Certificate File Displays the name of the SSL
Certificate files.
Private Key File Displays the name of the Private key
files.
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| Exporting Certificates in Bulk Using the Certificate Export Wizard

To edit the CA certificate, SSL certificate, and, Private Key, select the Trustpoint
name in the table and click Edit.

Click Next to continue.

Specify Destination Details (PEM - Redundant SSLSM)

You can export certificates to a redundant SSLSM. The Wizards will use the same
Trustpoint name as the selected Trustpoint on the redundant SSLSM. You can edit
the names if required.

Note Do not specify a Trustpoint name that already exists in the redundant SSLSM. If
the Trustpoint name is already present, the export will fail.

The following fields are displayed:

Field Description

Redundant SSLSM

IP Address Enter the IP address of the redundant
SSLSM.

User Name Enter the user name.

Password Enter password.

Enable Username Re-enter the user name to enable the
user

Enable Password Re-enter the password to confirm.

Trustpoints

SSL Certificate Subject Displays the list of SSL certificates.

Redundant SSLSM Trustpoint Displays the list of redundant
trustpoints of SSLSM

To edit the redundant SSLSM Trustpoint Name select the row in the table and
click Edit.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Exporting Certificates in Bulk Using the Certificate Export Wizard W

If you have selected the Export CA Certificate in Certificate Chains in the step
1 then the CA Certificates in Certificate Chains table with the following details
are displayed.

Fields Description

Certificate Authority (CA) Name Displays the chain of certificate
authority names.

Redundant SSLSM Trustpoint Displays the list of redundant
trustpoints of SSLSM

CRL Verification Select the CRL verification from the
given options.

To edit the redundant SSLSM Trustpoint Name select the row in the table and
click Edit.

Click Next to continue.

Specifying the Destination (PKCS#12)

You can select any one of the following destination for theX.509 Format:

e Remote System—To export the certificates and private keys to a remote
server using TFTP, FTP, SCP, or RCP.

e Redundant SSLSM—To export the certificates and private keys to a
redundant SSL services module.

Specify Destination Details (PKCS#12 - Remote System)

Specify the details of the Remote system where you want the certificates and
private keys to be exported.

The following fields are displayed:

| oL-6014-02
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| Exporting Certificates in Bulk Using the Certificate Export Wizard

Fields

Description

File Server

Protocol

Select from options:
e FTP
e RCP
e SCP
e TFTP

Server IP Address

IP address of the system.

Username Enter the user name

Password Enter the password.

Files

Directory Enter the path or location of the files.

SSL Certificate Subject

Displays the list of SSL Certificate
Subject.

PKCS#12 File

Displays the list of PKCS#12 Files.

To edit the PKCS#12 files, select the row in the table and click Edit.

Click Next to continue.

Specify Destination Details (PKCS#12 - Redundant SSLSM)

You can export certificates to a redundant SSLSM. The Wizards will use the same
Trustpoint name as the selected Trustpoint on the redundant SSLSM. You can edit

Note

the names if required.

You need to specify a staging area. The certificates are exported to the staging
area and then imported to the redundant SSLSM from the staging area.

Do not specify a Trustpoint name that already exists in the redundant SSLSM. If
the Trustpoint name is already present, the export will fail.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Exporting Certificates in Bulk Using the Certificate Export Wizard W

Field Description
Redundant SSLSM

IP Address Enter the IP address.
Username Enter the user name.
Password Enter the password.

Enable Username

Re-enter the user name to confirm the
user.

Enable Password

re-enter password to confirm.

Remote File Server

Protocol Select from the options below:
e FTP
e RCP
e SCP
e TFTP
Server IP Address Enter the server IP address.
Username Enter the user name.
Password Enter the password.

Files and Trustpoints

Directory

Enter the path or location of the files.

SSL Certificate Subject

Displays the list of SSL certificate
subject names.

PKCS#12 File

Displays the list of PKCS#12 files.

Redundant SSLSM Trustpoint

Displays the list of SSLSM trustpoints
that are redundant.

To edit the PKCS#12 files and Redundant SSLSM Trustpoints, select the SSL
Certificate Subject in the table and click Edit.

Click Next to continue.

| oL-6014-02
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| Viewing Certificate Trustpoints

Viewing Certificate Trustpoints

The Certificate Trustpoint page shows all certificate Trustpoints configured on
the SSL Services Module.

Figure 3-2 Public Key Infrastructure Page
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To view all Trustpoints:

Step1  Click Setup at the top of the window, click PKI in the left-most pane, and select
Certificate Trustpoints from the object Selector.
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Viewing Certificate Trustpoints

The following information is displayed for Trustpoints:

Field Description

Trustpoints

Trustpoint Name The name of the trustpoint associated
with the key pair.

CA Name Certificate Authority associated with
the Trustpoint.

Subject Name Subject name in the SSL certificate
associated with the Trustpoint

Expiry Date The expiry date of SSL certificate or
CA certificate which ever expires
earlier

Status Status of the associated CA certificate.

A [ icon indicates that the certificate
is valid.

A icon indicates that the certificate
invalid.

A icon indicates that the certificate
is valid only for less than 10 days.

A icon indicates that the certificate
is valid only for less than 20 days.

A icon indicates that the certificate
is valid only for less than 30 days.

Status will be displayed only for
Trustpoints with Certificates.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Viewing Certificate Trustpoints

Select a Trustpoint name from the table to view the following Trustpoint status

details.
Field Description
Trustpoint The trust point name. Click on the link

to view details on the trustpoint.

CA Certificate

Status

Status of the CA certificate.

A [ icon indicates that the certificate
is valid.

A icon indicates that the certificate
invalid.

A icon indicates that the certificate
is valid only for less than 10 days.

A icon indicates that the certificate
is valid only for less than 20 days.

A icon indicates that the certificate
is valid only for less than 30 days.

CA Name

Subject of the CA Certificate.

SSL Certificate

Status

Status of the SSL certificate.

Subject Name

Subject of the SSL certificate.

Keypair Name

Key pair to which the trustpoint is
associated.

Certificate Chain

Status

Status of the certificate chain.

Chain Length

Number of certificates in a chain.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Viewing Certificate Trustpoints

You can launch wizards to configure a Trustpoint. To launch the wizard, click
Setup Wizard, then select one of the following options:

e Configure a Certificate Trustpoint...
e Import Certificates from External PKI...

Select a Trustpoint, then click Delete to delete a trustpoint.

Certificate Trustpoint Grouper

You can group Trustpoints based on different common parameters.

To group the Trustpoints:

Step 1 Select one of the options:

¢ Group by Enrollment Status—to group Trustpoints based on the enrollment
status. The Trustpoints are displayed under the following groups.

— SSL Certificates—all Trustpoints that have an SSL Certificate.

— Enrollment Pending—all Trustpoints that have a CA certificate and key
pair configured but do not have an SSL certificate.

— CA Certificates—all Trustpoints that have a CA certificate configured
but the key pair is not configured. All the CA Trustpoints will be grouped
under this group.

— No Certificates—all Trustpoints that do not have any certificate
associated with it.

¢ Group by Expiry—to group Trustpoints based on the expiry date. The
Trustpoints are displayed under groups starting with the Trustpoints expiring
this month, then next month and so on.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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W Certificate Trustpoint Details

¢ Group by CA—to group Trustpoints by CA.
¢ No Grouping—to list all Trustpoints without any group.

Based on your selection, Trustpoints are grouped under the Trustpoints node in
the object Selector.

Certificate Trustpoint Details

You can view the configuration and certificate details of a selected Trustpoint.

Figure 3-3 Public Key Infrastructure Details
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Step 1

Step 2

Step 3

Certificate Trustpoint Details

Click Setup at the top of the window, click PKI in the left-most pane, and select
Trustpoints from the object Selector. The Trustpoint page appears.

Select a Trustpoint object from the logical group. You can group the Truspoints
using Trustpoint Grouper. For more on Certificate Trustpoint Grouper, see
Certificate Trustpoint Grouper, page 3-57.

Click Configuration Tab.
The following fields are displayed:

Field

Description

Trustpoint Name

The name of the Trustpoint.

Key Pair Name

The key pair associated with the
trustpoint.

Certificate
Subject The subject of the certificate.
IP Address The IP address of the module.

Certificate Purpose

The purpose of the certificate.

Include SSL Serial Number in Subject
Name

Select this option to include the
SSLSM serial number in the subject
name.

Enrollment

Enrollment Method

The enrollment method for the
certificate.

Example: copy-and-paste.

CA Server URL

The URL of the CA server.

Retry Count

Specifies how many time CVDM
should try to enroll the certificate with
the module.

Retry Period (min)

Duration between retries, in minutes.

Enable Auto-enrollment

Indicates whether auto-enrollment is
enabled for the certificate.

Regenerate keys on auto enrollment

Indicates whether the certificate
regenerates keys on autoenrollment.

| oL-6014-02
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W Certificate Trustpoint Details

Field

Description

CRL

x 500 CDP Information

x500 CDP information for the
certificate trustpoint.

CRL Validation

Effectiveness with which the CRL has
to be validated.

Values are:

e Default—If the trustpoint has been
selected to validate a certificate. If
the CRL is not in the database or
has expired, the SSL module
dowloads a CRL and saves it to the
database for later use. If the CRL
download fails, the SSL module
rejects the certificate being
validated.

e Optional— If the SSL module
finds a CRL in the database and
has not expired, then the SSL
module performs a CRL lookup. If
the SSL module does not find
CRL, the SSL module accepts the
certificate. The SSL module
makes no attempt to download a
CRL.

e Best-effort—If the SSL module
finds a CRL in the database and
has not expired, then the SSL
module performs a CRL lookup. If
the SSL module does not find
CRL, the SSL module attempts to
download a CRL. However, if the
CRL download fails, the SSL

module accepts the certificate.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Certificate Trustpoint Details

Field Description
Certificate ACL
Certificate ACL The name of the Certificate ACL

associated with the Trustpoint.

To view SSL certificate details, click SSL Certificate Tab.
To view CA Certificate details, click CA Certificate Tab.

To view Certificate chain details, click Certificate Chain Tab. The certificate
chain is displayed in tree format. Each node displays the subject of the certificate.

You can view the details of each certificate on the chain. The following fields are

displayed:
Field Description
Status Indicates the status of the selected

certificate chain.

A % icon indicates that the certificate
chain is complete.

A % icon indicates that the certificate
chain is incomplete.

Example: Certificate chain
is complete - CA certificate
is the Root.

Certificate Details

Certificate Shows the details of the certificate
including the details on how long the
certificate is valid.

Other details include:
e Version and serial number
e Issuer

e Subject

e Subject Public Key Information

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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W Certificate Trustpoint Details

Field Description

Associated Trustpoint Click on the link to view the Trustpoint
details.

Trustpoint name The name of the trustpoint associated
with the certificate.

Click Operations and select any one of the following Trustpoint operations:

Trustpoint Operation Description

Authenticate Select this option to authenticate a CA
certificate. You must configure the
enrollment method for the Trustpoint
to perform this operation.

For more information on
authenticating a Trustpoint, see
Authenticating Trustpoints, page 3-65

Enroll Select this option to create a certificate
request. You must configure the
enrollment method and key pair to
perform this operation.

For manual enrollment methods (Copy
and Paste/TFTP) a certificate request
will be created. For SCEP enrollment,
the certificate request will be sent to
the CA server.

For SCEP enrollment, you must
configure a Challenge Password. If
password is not configured, a
challenge password dialog box will
appear.

For more information on
authenticating a Trustpoint, see
Enrolling Trustpoints, page 3-65

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Certificate Trustpoint Details

Trustpoint Operation Description

Authenticate and Enroll Select this option to authenticate a CA
certificate and create a certificate
request. For manual enrollment (Copy
and Paste/TFTP) a certificate request
will be created. For SCEP enrollment,
the certificate request will be sent to
the CA server.

You must configure enrollment method
and key pair for the Trustpoint to
perform this operation.

For SCEP enrollment, you must
configure a Challenge Password. If
password is not configured, a
challenge password dialog box will
appear.

For more information on
authenticating a Trustpoint, see
Authenticating and Enrolling
Trustpoints, page 3-66

Import SSL Certificate Select this option to import an SSL
certificate issued by the CA for manual
enrollment (Copy and Paste/TFTP).

For more information on
authenticating a Trustpoint, see
Importing SSL Certificate Trustpoints,
page 3-66

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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W Certificate Trustpoint Details

Trustpoint Operation Description

Renew Select this option to create a new
certificate request. You can optionally
regenerate the keys when creating the
certificate request.

For manual enrollment methods, a
certificate request will be created. For
SCEP enrollment, the certificate
request will be sent to the CA server.

This option is enabled only for
Trustpoints with SSL certificate.

For more information on
authenticating a Trustpoint, see
Renewing Trustpoints, page 3-67

Export Select this option to export the
certificate and private key associated
with the Trustpoint. You can export the
certificate only if the private key is
exportable.

For more information on
authenticating a Trustpoint, see
Exporting Trustpoints, page 3-68

To edit the Trustpoint configuration, click Edit. For more information on editing
Trustpoints, see Editing Trustpoint Configuration, page 3-68

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Certificate Trustpoint Details

Authenticating Trustpoints

Step 1

Step 2

Step 3

The Trustpoint Authentication dialog box provides the authentication details and
the status.

To authenticate a truspoint, do the following:

Click Setup at the top of the window, click PKI in the left-most pane, and select
Certificate Trustpoints from the object Selector. The Trustpoint page appears.

Select a Trustpoint object from the logical group. You can group the Truspoints
using Trustpoint Grouper. The Truspoint details dialog box appears with the
configuration information.

Click Operations, then select Authenticate. The Authentication dialog box
appears.

Enrolling Trustpoints

Step 1

Step 2

Step 3

To enroll a certificate truspoint, do the following:

Click Setup at the top of the window, click PKI in the left-most pane, and select
Certificate Trustpoints from the object Selector. The Trustpoint page appears.

Select a Trustpoint object from the logical group. You can group the Certificate
Truspoints using Grouper. The Truspoint details dialog box appears with the
Configuration information.

Click Operations, then select Enroll.

| oL-6014-02

User Guide for CiscoView Device Manager for the Cisco SSL Services Module g



Chapter3  Managing Certificates |

W Certificate Trustpoint Details

Authenticating and Enrolling Trustpoints

Step 1

Step 2

Step 3

To authenticate and enroll a certificate truspoint, do the following:

Click Setup at the top of the window, click PKI in the left-most pane, and select
Certificate Trustpoints from the object Selector. The Trustpoint page appears.

Select a Trustpoint object from the logical group. You can group the Certificate
Truspoints using Grouper. The Truspoint details dialog box appears with the
Configuration information.

Click Operations, then select Authenticate and Enroll.

Importing SSL Certificate Trustpoints

Step 1

Step 2

Step 3

To import a SSL Certificate, do the following:

Click Setup at the top of the window, click PKI in the left-most pane, and select
Certificate Trustpoints from the object Selector. The Trustpoint page appears.

Select a Trustpoint object from the logical group. You can group the Certificate
Truspoints using Grouper. The Truspoint details dialog box appears with the
Configuration information.

Click Operations, then select Import SSL Certificate.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Certificate Trustpoint Details

Renewing Trustpoints

To renew a certificate trustpoint, do the following:

Step 1 Click Setup at the top of the window, click PKI in the left-most pane, and select
Certificate Trustpoints from the object Selector. The Trustpoint page appears.

Step2  Select a Trustpoint object from the logical group. You can group the Certificate
Truspoints using Grouper. The Truspoint details dialog box appears with the
Configuration information.

Step3  Click Operations, then select Renew. The Trustpoint Operation - Renew popup
dialog box appears with the following fields:

Field Description

Regenerate Select the check box to regenerate the
certificate.

Keypair Name Name of the key pair.

Usage Describes the use of the key.

Example: General Purpose.

Key Size (bits) Size of the key in bits.
Exportable Indicates whether you can export the
key.

Step4  Click OK to make changes.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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[ | Editing Trustpoint Configuration

Exporting Trustpoints

To export a SSL Certificate, do the following:

Step 1 Click Setup at the top of the window, click PKI in the left-most pane, and select
Certificate Trustpoints from the object Selector. The Trustpoint page appears.

Step2  Select a Trustpoint object from the logical group. You can group the Certificate

Truspoints using Grouper. The Truspoint details dialog box appears with the
Configuration information.

Step3  Click Operations, then select Export SSL Certificate.

Editing Trustpoint Configuration

Step 1 Click Setup at the top of the window, click PKI in the left-most pane, and select
Certificate Trustpoints from the object Selector.

Step2  Select a Trustpoint from the table, then click Edit. The Trustpoint Edit dialog box
appears with the following fields:

Field Action/Description

General

Trustpoint Name Name of the Trustpoint.

Key Pair Name Name of the key pair associated with

the Trustpoint.

Click | 7 | and select one of the
following:

* Create and use a new Key Pair
e Select an existing Key Pair

e Regenerate Key Pair

¢ Clear the Key Pair

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Editing Trustpoint Configuration

Field

Action/Description

Certificate Purpose

Select the purpose of the certificate
from the list:

e ssl-client

e ssl-server

Enrollment Configuration

Enrollment Method

Select one of the following certificate
enrollment method:

e SCEP
e TFTP
e Copy and Paste

CA Server URL

Enter the enrollment URL of the
certification authority server.

Retry Count

Enter the number of retries.

Retry Period

Enter the interval between the retries.

HTTP Proxy Enter the IP address of the HTTP
proxy.
Port Enter the port number for the HTTP

proxy.

Auto Renewal and Enrollment

Select the checkbox to enable auto
renewal and enrollment.

Renewal Percentage (%)

Enter the percentage of renewal.
Default is 100%.

Challenge Password

Enter the Challenge Password.

Click % I and select one of the
following options:

¢ Configure a Challenge Password

e (lear Challenge Password

Regenerate Keys on Re-enrollment

Select this checkbox to regenerate key
on re-enrollment.

CRL Configuration

| oL-6014-02
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i User Guide for CiscoView Device Manager for the Cisco SSL Services Module

Editing Trustpoint Configuration

Field

Action/Description

x.500 CDP Information

Enter the X.500 CDP information.

You can enter the hostname and port if
the CDP is in X.500 DN format. The
query takes the information in the
following form: ldap://hostname:[port]

For example, if a certificate being
validated has the following:

e The X.500 DN is configured with
CN=CRL,0=Cisco,C=US

e The associated trustpoint is
configured with crl query
1dap://10.1.1.1

then the two parts are combined to
form the complete URL as follows:

ldap://10.1.1.1/CN=CRL,0=Cisco,C=
US.

Note The trustpoint should be
associated with the issuer
certificate authority certificate
of the certificate being
validated. If there is no such
trustpoint in the database, the
complete URL cannot be
formed, and CRL download
cannot be performed.
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Editing Trustpoint Configuration

Field

Action/Description

CRL Validation

Select the type of CRL validation to be
used for the certificate:

Default—If the trustpoint has been
selected to validate a certificate. If
the CRL is not in the database or
has expired, the SSL module
downloads a CRL and saves it to
the database for later use. If the
CRL download fails, the SSL
module rejects the certificate
being validated.

Optional— If the SSL module
finds a CRL in the database and
has not expired, then the SSL
module performs a CRL lookup. If
the SSL module does not find
CRL, the SSL module accepts the
certificate. The SSL module
makes no attempt to download a
CRL.

Best-effort—If the SSL module
finds a CRL in the database and
has not expired, then the SSL
module performs a CRL lookup. If
the SSL module does not find
CRL, the SSL module attempts to
download a CRL. However, if the
CRL download fails, the SSL
module accepts the certificate.

Certificate ACL

Certificate ACL

Enter the Certificate ACL information.

Step 3 Modify the values, then click OK.
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[ | Editing Trustpoint Configuration

Selecting Available ACLs

The following information appears:

Field Action/Description

Certificate ACLs The name of the certificate ACL.

Select ACLs from the table, then click OK.

Selecting Available Key Pairs

The following information appears:

Field Action/Description
Key Pair Name The name of the key pair.
Key Size The size of the key pair.

Select key pairs from the table, then click OK.
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Certificate Hierarchy

Certificate Hierarchy

Step 1

Step 2

Certificate Hierarchy helps you to browse through the certificates imported on the
SSLSM and visualize the certificate hierarchy. You can also see the validity status
and the certificate chain status in the certificate tree.

In the Associated Trustpoints table, you have the hyperlinks to the associated
Trustpoints. You can view and configure the trustpoints by clicking the hyperlink.

To view the Certificate Hierarchy:

Click Setup at the top of the window, click PKI in the left-most pane, and select
Certificate Hierarchy from the object Selector. The certificate tree appears in the
content pane.

Select a certificate from the certificate hierarchy tree. The details of the selected
certificate is displayed in the Certificate Details box and the associated Trustpoint
names appears in the Associated Trustpoint box.
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Deleting Certificates

Figure 3-4
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Deleting Certificat
Step1  Click Setup at the top of the window, click PKI in the left-most pane, and select

Trustpoints from the object Selector.

Step 2

Step3  Click Delete.

Select a Trustpoint from the table.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Challenge Password

How Do I...

Challenge password is required for SCEP enrollment. If you have not configured
a challenge password, challenge password dialog will be prompted.

This password is necessary in the event that you ever need to revoke your
certificate(s). When you ask the CA administrator to revoke your certificate, you
must supply this challenge password as a protection against fraudulent or
mistaken revocation requests.

The Challenge Password dialog box has got two fields. Challenge Password and
Confirm Password. Enter the password and confirm it. Click OK to continue.

This section describes on how to achieve a task. The following questions are
answered:

How Do I Import an SSL Certificate and Private Key to SSLSM?, page 3-76
How do I Import a CA Certificate Chain on the SSLSM?, page 3-77

How do I generate a Certificate Signing Request (CSR)?, page 3-78

How do I import the SSL certificate obtained using CSR?, page 3-81

How Do I Export Certificates and Private Keys from SSLSM?, page 3-82
How Do I Renew an SSL Certificate?, page 3-82

| oL-6014-02
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How Do | Import an SSL Certificate and Private Key to SSLSM?

Step 1
Step 2
Step 3

The Certificate Import Wizard helps you to import the SSL certificate and the
private key on the SSLSM. If you are importing the SSL certificate and private
key from your client machine, you could also import the associated CA certificate
chain.

Click Setup in the CVDM-SSLSM task bar.The Setup page appears
Click Wizards in the left-most pane. The Setup Wizard page appears.

Select Import Certificates and Private key, then click Launch the Selected
Task. The Certificate Import Wizard appears.

You can import files in any of the following format:
e PKCS#12
¢ X.509 PEM
e X.509 DER
e PKCS#7

When creating a PKCS#12 file, include the entire certificate chain, from server
certificate to root certificate, and public and private keys. You can also generate
a PKCS#12 file from the module and export it.

If you are using SSH, we recommend using SCP when importing or exporting a
PKCS#12 file. SCP authenticates the host and encrypts the transfer session.

For details on Certificate Import Wizard, see Import Certificates and Private Key,
page 3-4.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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How do | Import a CA Certificate Chain on the SSLSM?

Step 1
Step 2
Step 3
Step 4

Step 1

Step 2

Step 3

The Certificate Trustpoint Setup Wizard helps you to Import a CA certificate
chain.

To configure a certificate Trustpoint:

Click Setup in the task bar. The Setup page appears.
Click Wizard in the left-most pane. The Wizards information page appears.
Click the Certificate Wizards. The Certificate Wizards page appears.

Select Configure a Certificate Trustpoint, then click Launch the Selected
Task to launch the wizard.

You could Import a CA certificate chain using CA certificates in X.509 Privacy
Enhanced Mail (PEM) format or PKCS#7 format.

Importing a CA certificate chain in PEM format

To import a CA certificate chain using CA certificates in PEM format, you need
to perform the following tasks:

Specify a Trustpoint name prefix. When importing a certificate chain, a CA
certificate Trustpoint is setup for each of the CA certificates in the certificate
chain. Select the CA Trustpoint.

Select X.509 PEM from the format options, select the source from which you wish
to import the CA certificates and select the Import a CA Certificate Chain
option.

Specify the CA certificates in the certificate chain. You must specify the CA
certificates starting from the root CA certificate (self-signed certificate) to your
subordinate CA. A Trustpoint name is automatically generated for the CA
Trustpoints based on the prefix specified in Step 1. You can edit the Trustpoint
names using the CA Trustpoints tab.Importing a CA certificate chain in PKCS#7
format

Review the summary and click Finish. A status dialog will be launched
displaying the status of the certificate Trustpoint setup.

| oL-6014-02
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How Do I...

Step 1

Step 2

Step 3

To import a CA certificate chain in PKCS#7 format, perform the following
tasks:

Specify a Trustpoint name prefix. When importing a certificate chain, a CA
certificate Trustpoint will be setup for each of the CA certificates in the certificate
chain. Select the CA Trustpoint.

Select PKCS#7 from the format options. To import a PKCS#7 file from your
client machine select the Local Hard Disk option and specify the PKCS#7 file.
The wizard will decode the PKCS#7 file and list all the CA certificates in the file.
A default Trustpoint name is automatically generated for each of the CA
certificates based on the Trustpoint name prefix specified in Step 1. You can
double-click on the row to edit the Trustpoint name.

Specify the CA certificates in the certificate chain. You must specify the CA
certificates starting from the root CA certificate (self-signed certificate) to your
subordinate CA. A Trustpoint name will be automatically generated for the CA
Trustpoints based on the prefix specified in Step 1. You can edit the Trustpoint
names using the CA Trustpoints tab.

Review the summary and click Finish. A status dialog will be launched
displaying the status of the certificate Trustpoint setup.

How do | generate a Certificate Signing Request (CSR)?

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module

N

Note

To generate a Certificate Signing Request (CSR), do the following tasks:

e [Ifthe Certificate Authority (CA) issuing your SSL certificate is a subordinate
CA, import all the CA certificates in the certification path. If your CA is a
root CA (self-signed CA certificate), you can skip this task.

e Configure a certificate Trustpoint, authenticate the CA certificate
corresponding to the issuer of your SSL certificate, and generate a CSR.

The Certificate Trustpoint Setup Wizard helps you perform the above tasks.

Importing a CA certificate chain

If the issuing CA certificate is a self-signed certificate, you can skip this step.

oL-6014-02 |
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Step 1
Step 2
Step 3
Step 4

Step 5

Step 6

Step 7

HowDol.. H

For more details, see How do I Import a CA Certificate Chain on the SSLSM?
Configuring a Certificate Trustpoint

To configure a certificate Trustpoint:

Click Setup in the task bar. The Setup page appears.
Click Wizard in the left-most pane. The Wizards information page appears.
Click the Certificate Wizards. The Certificate Wizards page appears.

Select Configure a Certificate Trustpoint, then click Launch the Selected
Task to launch the wizard.

Specify a Trustpoint name and select the Proxy Service Trustpoint option. By
default, a new RSA key pair will be generated with the same name as the
Trustpoint. Specify the key size. If you already have the RSA key pair on the
SSLSM, select the Use an Existing Key Pair option and specify the key pair
name.

Specify the certificate attributes - subject Distinguished Name (DN), unstructured
name, unstructured IP address and, certificate purpose. These attributes are
optional.

Specify the enrollment method. SSLSM supports three methods of certificate
enrollment.

¢ Automatic Enrollment using Simple Certificate Enrollment Protocol
(SCEP)

If SCEP is used, SSLSM sends the certificate request (CSR) to the specified
SCEP server. The SSL certificate issued by the CA is automatically imported.

e Manual Enrollment using TFTP

In this method, you must specify a filename on your TFTP server.
For example,
tftp://10.77.241.10/certs/mycert

SSLSM adds file extensions to the filename as follows:

— .ca when downloading the CA certificate from the TFTP server.

For example mycert.ca

- .req when copying the generated CSR to the TFTP server.

For example mycert.req
— .crt when downloading the SSL certificate from the TFTP server.

| oL-6014-02
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i User Guide for CiscoView Device Manager for the Cisco SSL Services Module

How Do I...

Step 8

Step 9

For example mycert.crt
e Manual Enrollment using Copy-and-Paste

In this method, the CSR is displayed to you. You can copy the CSR and
submit it to your CA.

If certificate Trustpoints exists on the SSLSM, and are enrolled with CAs, the CA
field lists the corresponding CA names. If you select a CA, the corresponding
enrollment configuration is applied to the new Trustpoint.

Specify the CA certificate

This step applies only to Copy-and-Paste method. When using the copy-and-paste
method, you must specify the certificate of your CA issuing the SSL certificate.

For TFTP method, the SSLSM will download the CA certificate from the TFTP
SErver.

Select Authenticate the CA and Generate a CSR option from the setup task
options and click Next.

Review the summary and click Finish. A status dialog will be launched displaying
the status of the certificate Trustpoint setup.

When authenticating the CA certificate, the MDS5 fingerprint of the CA certificate
will be displayed. You need to manually verify the fingerprint and accept the
certificate. For copy-and-paste method, the CSR will be displayed. For TFTP
method, the CSR will be copied to the TFTP server.

oL-6014-02 |
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How do | import the SSL certificate obtained using CSR?

Step 1
Step 2
Step 3
Step 4
Step 5

Step 1

Step 2

Step 3

Importing SSL Certificate using Certificate Trustpoint Setup Wizard

If you are using TFTP enrollment method, copy the SSL certificate obtained using
the CSR to the TFTP server. You must use the filename configured in the
Trustpoint with a.crt file extension.

Specify the name of the certificate Trustpoint that you setup to generate the CSR.
Skip this step.

Skip this step.

Select Import SSL Certificate from the setup task option.

This step applies only if you are using copy-and-paste enrollment method. Copy
and paste the SSL certificate in PEM format.

Review the summary and click Finish. A wizard status dialog will be launched
displaying the status of the SSL certificate import.

Importing SSL Certificate from Trustpoint Details Screen

To import a SSL Certificate, do the following:

Click Setup at the top of the window, click PKI in the left-most pane, and select
Certificate Trustpoints from the object Selector. The Trustpoint page appears.

Select a Trustpoint object from the logical group. The Truspoint details screen
appears with the Configuration information.

Click Operations, then select Import SSL Certificate.

Review the summary and click Finish. A wizard status dialog will be launched
displaying the status of the SSL certificate import.

| oL-6014-02
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How Do | Export Certificates and Private Keys from SSLSM?

The Certificate Export Wizard helps you to export the SSL certificate and the
private key from the SSLSM. If you are exporting the SSL certificate and private
key to your client machine, you could also export the associated CA certificate
chain.

For details of Certificate Export Wizard, see Export Certificates and Private Keys,
page 3-7.

How Do | Renew an SSL Certificate?

Step 1

Step 2

Step 3
Step 4

You can renew Certificates and Key pairs.

Click Setup at the top of the window, click PKI in the left-most pane, and select
Trustpoints from the object Selector. The Trustpoint page appears.

Select a Trustpoint node from the logical group. You can group the Truspoints
using Trustpoint Grouper.

Select a Trustpoint from the list.
Click Operations, then select Renew from the popup menu.

Review the summary and click Finish. A status dialog will be launched displaying
the status of the certificate Trustpoint setup.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Managing Key Pairs

The following topics are described in this section:
e Understanding Key Pairs, page 4-1
e Viewing Key Pairs, page 4-2
e Adding Key Pairs, page 4-4
e Deleting Key Pairs, page 4-6
e Key Pair Wizard, page 4-6
e How Do I..., page 4-16

Understanding Key Pairs

RSA is the public key cryptographic system developed by Ron Rivest, Adi
Shamir, and Leonard Aldeman. RSA algorithm is widely used by certificate
authorities and SSL servers to generate key pairs. Each certificate authority and
each SSL server has its own RSA key pair. The SSL server sends its public key to
the certificate authority when enrolling for a certificate. The SSL server uses the
certificate to prove its identity to clients when setting up the SSL session.

Note  The SSL Services Module supports only general-purpose keys.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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W Viewing Key Pairs

When you generate general-purpose keys, only one pair of RSA keys is generated.
Named key pairs allow you to have multiple RSA key pairs, enabling the Cisco
I0S software to maintain a different key pair for each identity certificate. We
recommend that you specify a name for the key pairs.

When you generate RSA keys, you are prompted to enter a modulus length in bits.
The SSL Services Module supports modulus lengths of 512, 768, 1024, 1536, and
2048 bits. Although you can specify 512 or 768, we recommend a minimum
modulus length of 1024. A longer modulus takes longer to generate and takes
longer to use, but it offers stronger security.

Viewing Key Pairs

The Key Pairs page shows all key pairs configured on a Trustpoint.

To view all Key Pairs:

Step1  Click Setup at the top of the window, click PKI in the left-most pane.
Step2  Select Trustpoints > Key Pairs from the object selector.

The following information is displayed for Key Pairs:

Field Description
Name Name associated with the Key pair.
Key Size Size of the keys in bits.

Choose the size of the key modulus
from the list. Supported key sizes are:

e 512
e 768
e 1024
e 1536
e 2048

Usage The purpose of the key. Only general
purpose keys are supported by the
SSLSM.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Viewing Key Pairs W

Field

Description

Generation / Import Time

The time when the key pair was
generated or imported to the SSLSM.

Exportable

Check box indicating if the key pair
can be exported.

You can specify that a key is exportable
during key generation. Once the key is
generated as either exportable or not
exportable, it cannot be modified for
the life of the key.

Select a key pair to view details. The following details are displayed at the lower

part of the content window:

Key Pair Details

Field

Description

General

Key Pair Name

Name associated with the Key pair

Key Size (bits)

Size of the keys in bits.

Usage

The purpose of the key. Only general
purpose keys are generated by the
SSLSM.

Generation/Import Time

The time when the key pair was
generated or imported to the SSLSM.

Exportable

Check box indicating if the key pair
can be exported or not.

You can specify that a key is exportable
during key generation. Once the key is
generated as either exportable or not
exportable, it cannot be modified for
the life of the key.

Associated Trustpoints

| oL-6014-02
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Field Description

Trustpoint Name The names of the Trustpoints to which
the key pair is associated.

Subject Name Subject name of the certificate using
the key.

Public Key The hexadecimal value of the public
key.

Click Add to add a new key pair.

Select a key pair from the table, then click Delete to delete a key pair.
Click Import to launch the Key Pair Import Wizard.

Click Export to launch the Key Pair Export Wizard.

Adding Key Pairs

Step1  Click Setup at the top of the window, click PKI in the left-most pane.
Step2  Select Trustpoints > Key Pairs from the object selector.

Step3  Click Add. Add New Key Pair dialog box appears.

Stepd  Modify the appropriate values.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Field Description

Key Pair Name Name associated with the Key pair.
Usage The purpose of the key.

Key Size (bits) Size of the keys in bits

Choose the size of the key modulus
from the list. Supported key sizes are:

e 512
e 768
e 1024
e 1536
e 2048.
Exportable Checkbox indicating if the key pair can

be exported.

You can specify that a key is exportable
during key generation. Once the key is
generated as either exportable or not
exportable, it cannot be modified for
the life of the key.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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W Deleting Key Pairs

Deleting Key Pairs

You can delete key pairs. Deleting a key pair will delete all Certificates issued
using the selected keys.

To delete key pairs:

Step1  Click Setup at the top of the window, click PKI in the left-most pane. elect
Trustpoints > Key Pairs from the object selector.

Step2  Click Delete. Key Pair Deletion confirmation box appears.

Step3  Click Yes to delete the key pair.

Key Pair Wizard

You can import and export key pairs in privacy-enhanced mail (PEM) file format.
The Key Pair Wizard allows you to import and export key pairs.

e Key Pair Import Wizard, page 4-7
e Key Pair Export Wizard, page 4-10

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Key Pair Wizard

Key Pair Import Wizard
The Key Pair wizard allows you to import RSA Key pairs in PEM format to
SSLM.

To import a Key Pair:

Step1  Specify Key Pair Name and Source.
Step2  Specify Public and Private Keys.
Step3  Click Finish.

Specify Key Pair Name and Source

This page of the key pair import wizard allows you to enter key pair name and the
source from where the key pair has to be imported.

The following fields are displayed:

Field Action/Description
Key Pair Name* The name of the key pair.
Allow Key Pair Export Select the check box if you want to

allow key pair export.

You can specify that a key is exportable
during key generation. Once the key is
generated as either exportable or not
exportable, it cannot be modified for
the life of the key.

Local Hard Disk Select this if you are importing key
pair from a local hard disk.

Copy and Paste Select this if you are using copy and
paste to import the key pairs.

Remote System Select this if you are importing from a
remote system.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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W Key Pair Wizard

Public and Private Keys (Local Hard Disk)

If you select Local Hard Disk, the following fields appear:

Field Description

Public Key File The public key file you need to export.
Enter the absolute path or browse and
select the file from the local hard disk.

Private Key File The private key file you need to export.
Enter the absolute path or browse and
select the file from the local hard disk.

Passphrase The passphrase to be used to encrypt
the key.

Public and Private Keys (Copy-and-Paste)

If you select Copy-and-Paste, the following fields appear:

Field Description
Public Key Copy-and-paste the public key here.
Passphrase The passphrase that is used to protect

the private key.

The passphrase can be any phrase
including spaces and punctuation
except for question mark (?).
Passphrase protection associates a pass
phrase to the key. The passphrase is
used to encrypt the key when it is
exported. When the key is imported,
you must enter the same pass phrase to
decrypt it.

Private Key Copy-and-paste the private key.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Public and Private Keys (Remote System)

Key Pair Wizard

If you select Remote System, the following fields appear:

Field Description

Protocol The protocol to used for the transfer.
IP Address The IP address of the Remote System.
User Name The user name.

Password Password

Public Key File Name

The absolute path of the public key
file.

Private Key File Name

The absolute path of the public key
file.

Passphrase

The passphrase that is used to protect
the private key.

The passphrase can be any phrase
including spaces and punctuation
except for question mark (?).
Passphrase protection associates a pass
phrase to the key. The passphrase is
used to encrypt the key when it is
exported. When the key is imported,
you must enter the same pass phrase to
decrypt it.

| oL-6014-02
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W Key Pair Wizard

Key Pair Export Wizard

Step 1

Step 2
Step 3
Step 4
Step 5

Step 6

The Key Pair Export Wizard allows you to export an RSA key pair in PEM
format.

You can export key pairs to a local hard disk or a remote system. Alternatively
you can copy-and-paste the key pair values.

To export key pairs:

Click Setup at the top of the window, click PKI in the left-most pane, and select
Trustpoints > Key Pairs from the object selector.

Select a Key Pair from the table.
Click Export. The Export Key Pair dialog box appears.
Select a Destination type.

Specify destination file names and encryption parameters. Fields in the dialog box
varies according to the destination type you select.

Click Finish to complete exporting.

Key Pair Destination

The Key Pair Destination page of the wizard allows you to select the key pair
destination.

You can select any one of the destination types:
e Local Hard Disk—to export the keys to a client workstation.
e Copy-and-Paste—to copy-and-paste the public and private keys.

e Remote System—to export the keys to a remote system using TFTP, FTP,
SCP, or RCP.

If you have selected Local Hard disk, next step is to specify Destination Files and
Encryption Parameters (Local Hard Disk), page 4-11.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Key Pair Wizard

If you have selected Copy-and-paste, next step is to specify Encryption
Parameters (Copy-and-paste), page 4-13.

If you have selected Remote System, next step is to specify Destination Files and
Encryption Parameters (Remote System), page 4-14.

Destination Files and Encryption Parameters (Local Hard Disk)

The Destination Files and Encryption Parameters page of the wizards allows you
to enter the destination files names of the public and private key on the client

station, and encryption parameters.

If you select Local Hard Disk the following fields appear:

Field

Description

Public Key File

The public key file you need to export.
Enter the absolute path or browse and
select the file from the local hard disk.

Private Key File

The private key file you need to export.
Enter the absolute path or browse and
select the file from the local hard disk.

Encryption

The encryption to used for the key pair.

The following encryption algorithms
are supported:
e des—Specifies the 56-bit
DES-CBC encryption algorithm.

e 3des—Specifies the 168-bit DES
(3DES) encryption algorithm.

| oL-6014-02
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Field

Description

Passphrase

The passphrase that is used to protect
the private key.

The passphrase can be any phrase
including spaces and punctuation
except for question mark (?).
Passphrase protection associates a pass
phrase to the key. The passphrase is
used to encrypt the key when it is
exported. When the key is imported,
you must enter the same pass phrase to
decrypt it.

Confirm Passphrase

Confirm the passpharse to decrypt the
key pair.

Enter the details, then click Next.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Key Pair Wizard

Encryption Parameters (Copy-and-paste)

You can enter the encryption type and pass phrase to protect the private key.

The following fields appear:

Field Description

Encryption Encryption used by the key pair.

The following encryption algorithms
are supported:
e des—Specifies the 56-bit
DES-CBC encryption algorithm.

e 3des—Specifies the 168-bit DES
(3DES) encryption algorithm.

Passphrase The passphrase that is used to protect
the private key.

The passphrase can be any phrase
including spaces and punctuation
except for question mark (?).
Passphrase protection associates a pass
phrase to the key. The passphrase is
used to encrypt the key when it is
exported. When the key is imported,
you must enter the same pass phrase to
decrypt it.

Confirm Passphrase Confirm the passphrase to decrypt the
key pair.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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W Key Pair Wizard

Destination Files and Encryption Parameters (Remote System)

The Destination Files and Encryption Parameters page of the wizards allows you
to enter the destination files names of the public and private key on the client
station, and encryption parameters.

If you select Remote System, the following fields appear:

Field Description
Protocol The protocol to used for the transfer.
IP Address The IP address of the remote system.
User Name The user name.
Password Password to be used for the remote
system.
Public Key File The absolute path of the public key
file.
Private Key File The absolute path of the public key
file.
Encryption Encryption used by the key pair.
The following encryption algorithms
are supported:
e des—Specifies the 56-bit
DES-CBC encryption algorithm.
e 3des—Specifies the 168-bit DES
(3DES) encryption algorithm.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Key Pair Wizard

Field

Description

Passphrase

The passphrase that is used to protect
the private key.

The passphrase can be any phrase
including spaces and punctuation
except for question mark (?).
Passphrase protection associates a pass
phrase to the key. The passphrase is
used to encrypt the key when it is
exported. When the key is imported,
you must enter the same pass phrase to
decrypt it.

Confirm Passphrase

Confirm the passphrase to used for
decrypting the key pair.

Key Pair Wizard Summary

When you use a wizard to perform a configuration, the wizard's Summary screen
displays the values that you have configured. You can examine those values and
click the wizard's Back button to return to a screen on which you need to make a
change. When you have made the changes, click the Finish button to save your

changes and leave the wizard.

Key Pair Wizard Status

The Key Pair Wizard Status dialog box provides the status details of the
Trustpoint configuration tasks. The details displayed vary according to the task
you selected. The dialog box displays the status against each task.

The configuration performed on the module is displayed in the content area. If any
task fails, you can review the task details and take necessary action.

| oL-6014-02
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How Do I...

The How do I section explains how to accomplish a task using the CVDM.
The following tasks are explained:

e How Do I Add a New Key Pair?

e How Do I Import a Key Pair?

How Do | Add a New Key Pair?

To add a new key pair:

Step 1 Click Setup at the top of the window, click PKI in the left-most pane.
Step2  Select Trustpoints > Key Pairs from the object selector.

Step3  Click Add. Add New Key Pair dialog box appears.

Step4  Modify the appropriate values in the page, the click OK.

How Do | Import a Key Pair?

You can use the key pair import wizard to import a key pair. The Key Pair wizard
allows you to import RSA Key pairs in PKCS12 or PEM format to SSLM.

To import a key pair:

Step 1 Launch the Key Pair Import Wizard.
Step2  Enter key pair name and the source from where the key pair has to be imported.

Step3  Enter the public and private key information.
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Managing CA Pools

Certification authorities (CAs) are responsible for managing certificate requests
and issuing digital certificates. A digital certificate contains information, such as
a name, serial number, company, department, or IP address, that identifies a user
or device. A digital certificate also contains a copy of the entity's public key. A
CA can be a trusted third party, such as VeriSign, or a private (in-house) CA that
you establish within your organization.

CVDM-SSLSM allows you to create trusted CA pools, which lists the CAs that
the module can trust. You can select Trustpoints and create pools and assign a CA
pool to one or more proxy services.

The following topics are described in this section:
e Viewing CA Pools, page 5-2
e Assigning CA Pools to Proxy Services, page 5-4
e Adding CA Pools, page 5-5
e Editing CA Pools, page 5-6
e Deleting CA Pools, page 5-7
e How Do I..., page 5-7
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M Viewing CA Pools

Viewing CA Pools

You can view information on all CA Pools configured on SSLSM.

Step 1

To view CA Pools:

Click Setup at the top of the window, click PKI in the left-most pane, and select
Trustpoints > CA Pools from the object selector. The CA Pools page appears.

This page displays the following fields:

Field

Description

Name

Name of the CA Pool.

Number of Trustpoints

Number of Trustpoints in the Pool.

Number of Proxy Services (Use Count)

Number of Proxy Services using the
CA Pool.

Status

Status of the CA Pool.

A % icon indicates that all certificates
in the CA Pool are valid. A & icon
indicates that some certificates in the
CA Pool are invalid. A . icon
indicates that all certificates in the CA
Pool are invalid.
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Viewing CA Pools W

Step2  Select a CA Pool from the table. The following details are displayed:

Field Description
Trustpoint Name The name of the associated Trustpoint.
Status The status of the associated Trustpoint.

A [ icon indicates that the certificate
is valid. A icon indicates that the
certificate invalid.

CA Name The name of the certification authority
associated with the Trustpoint.

Associated Proxy Services

Service Name Name of service.
Client Side (Virtual) Virtual IP address and port of the proxy
service.

To assign CA Pools to proxy services, select a CA Pool, then click Assign to
Proxy Services....

To add a new CA Pool, click Add.
To edit a CA Pool, select a CA Pool, then click Edit.
To delete a CA Pool, select a CA Pool, then click Delete.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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H Assigning CA Pools to Proxy Services

Assigning CA Pools to Proxy Services

Step 1

Step 2

Step 3

Step 4

You can select proxy services and assign a CA Pool to the selected proxy service.

To assign CA Pools to proxy services:

Click Setup at the top of the window, click PKI in the left-most pane, and select
Trustpoints > CA Pools from the object selector. The CA Pools page appears.

Select a CA Pool, then click Assign to Proxy Services. The Assign CA Pool to
Proxy Services dialog box appears.

The following fields appear:

Field Description

Pool Name Name of the CA Pool.

Proxy Service Name Name of the Proxy Service.

Client Side (Virtual) IP address and port of the proxy
service.

Selected Proxy Services The list of selected proxy services.

Select a Proxy Service name from the list, and click Add>> to assign the CA Pool
to the service. Use << Remove to remove the CA pool from the list of services.
Use Clear All to remove all the pools from the service.

Click OK to complete assigning the CA pool to the selected Proxy Services.
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Adding CA Pools

Step 1

Step 2

Step 3
Step 4

Step 5

You can add new CA Pools and add Trustpoints to the CA pools.
To add CA Pools:

Click Setup at the top of the window, click PKI in the left-most pane, and select
Trustpoints > CA Pools from the object selector. The CA Pools page appears.

Click Add. The Add CA Pool dialog box appears.
The following fields appear:

Field Description

Pool Name Name of the CA Pool.
Trustpoint Name Name of the Trustpoint.

CA Name Name of Trust CA Pool.

Pool Members Members in the select CA Pool.

Enter a Pool Name.

Select a Trustpoint name from the list, and click Add>> to add the Trustpoint to
the CA Pool. Use << Remove to remove the trustpoint name from the pool. Use
Clear All to remove all the members of the pool.

Click OK to complete adding the CA Pool.

| oL-6014-02
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W Editing CA Pools

Editing CA Pools

Step 1 Click Setup at the top of the window, click PKI in the left-most pane, and select
Trustpoints > CA Pools from the object selector. The CA Pools page appears.

Step 2 Select a CA Pool from the table, and Click Edit. The Edit CA Pool dialog box
appears.

The following fields appear:

Field Description

Pool Name Name of the CA Pool.
Trustpoint Name Name of the Trustpoint.

CA Name Name of Trust CA Pool.

Pool Members Members in the select CA Pool.

Step3  Select a Trustpoint name from the available Trustpoints, and click Add>> to add
the Trustpoint to the CA Pool. Use << Remove to remove the trustpoint name
from the pool members. Use Clear All to remove all the members of the pool.

Step4  Click OK to complete editing the CA Pool.
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Deleting CA Pools

To delete CA Pools:

Step 1 Click Setup at the top of the window, click PKI in the left-most pane, and select
Trustpoints > CA Pools from the object selector. The CA Pools page appears.

Step 2 Select a CA Pool from the table, and click Delete.

Step3  Confirm delete action. A warning message appears if the selected CA Pool is
associated with any Proxy Service.

How Do l...

This section describes on how to achieve a task. The following question is
answered:

e How do I add a new CA Pool?

How do | add a new CA Pool?

Step 1 Click Setup at the top of the window, click PKI in the left-most pane, and select
Trustpoints > CA Pools from the object selector. The CA Pools page appears.

Step2  Click Add. The Add CA Pool dialog box appears.
Step3  Enter a Pool Name.

Step4  Select a Trustpoint name from the list, and click Add >> to add the Trustpoint to
the CA Pool. Use << Remove to remove the trustpoint name from the pool. Use
Clear All to remove all the members of the pool.

Step5 Click OK to complete adding the CA Pool.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Managing Certificate ACLs

Certificates are used to identify an entity (a user or device) and, using fields
within the certificate, to associate attributes with that entity. The certificates
include several fields that determine whether the entity is authorized to perform a
specified action. The Certificate Security Attribute-Based Access Control feature
adds a new command, crypto CA certificate ACL, and new fields to the certificate
that create the certificate-based access control list (ACL).

The certificate-based ACL specifies one or more fields within the certificate and
an acceptable value for each specified field. You can specify which fields within
a certificate should be checked and which values those fields may or may not
have. There are six logical tests for comparing the field with the value:

e equal

e not equal

e contains

e does not contain

e less than

e greater than or equal

If more than one field is specified within a single certificate-based ACL, the tests
of all of the fields within the ACL must succeed to match the ACL.

The same field may be specified multiple times within the same ACL.

More than one ACL may be specified. Each ACL will be processed in turn until a
match is found or all of the ACLs have been processed.

CVDM-SSLSM allows you to define certificates (Attribute-Based Access
Control) / Certificate ACLs based on the peer certificate attributes.

| oL-6014-02
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W Viewing Certificate ACLs

These topics describe usage of certificate-based ACLs in CVDM-SSLSM:
e Viewing Certificate ACLs, page 6-2
e Adding Certificate ACL, page 6-5
e Editing Certificate ACLs, page 6-7
e Assigning Certificate ACLs to Trustpoints, page 6-4
e Deleting Certificate ACLs, page 6-9

Viewing Certificate ACLs

You can view all certificate ACLs configured in the device.

Step1  Click Setup at the top of the window, click PKI in the left-most pane, and select
Certificate Trustpoints > Certificate ACLs from the object selector.

The following fields appear:

Field Description

Name Name or tag associated with the
Certificate ACL

Number of ACL Entries Number of ACL entries

Number of Trustpoints (Use Count) Number of Trustpoints.

To view the details of a certificate ACL, select a certificate ACL from the table.
The following details are displayed at the lower section of the content pane:

Field Description

Certificate ACL Details: <Certificate ACL name>

Certificate ACL Entries and Criteria

Sequence The sequence numbers of the
Certificate ACL entries.
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Viewing Certificate ACLs

Select a certificate ACL entry by selecting the corresponding sequence number to
view the details.

Field Description

Certificate Field The Certificate Field to be examined
for Access Control.

The field name is one of the following
case-insensitive name strings or a date:

e subject-name

® issuer-name

e unstructured-subject-name
e alt-subject-name

* name

e valid-start

e expires-on

Match Condition The following match conditions are
supported:

e Equals (eq)

e Not Equals (neq)

e Contains (co)

e Not Contains (nc)

e Less than (It)

e Greater than or Equals (ge)

Match Value The name or date to test with the
logical operator assigned by match
criteria.

Select a certificate ACL from the list, then click Assign to Trustpoints to assign
a certificate ACL to a trustpoint.

Click Add to add a certificate ACL.
To edit a certificate ACL, select a certificate ACL and click Edit.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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To delete a certificate ACL, select a certificate ACL and click Delete.

To view Trustpoints associated with a certificate ACL, select a certificate ACL
and click View Associated Trustpoints.

Assigning Certificate ACLs to Trustpoints

You can view all certificate ACLs configured in the device.

Step1  Click Setup at the top of the window, click PKI in the left-most pane, and select
Trustpoints > Certificate ACLs from the object selector.

Step2  Select a Certificate ACL from the list, and click Assign to Trustpoints. The
Assign to Trustpoint dialog box appears.

The following fields appear:

Field Description

Certificate ACL Name The ACL name of the certificate.

Trustpoint Name The trustpoint associated with the
Certificate ACL.

CA Name The CA name of the associated
trustpoint

Subject Name The subject name of the certificate.

Selected Trustpoints Trustpoint associated with the
certificates.

Step3  Select the Trustpoints from the list, and click Add>> to assign the certificate
ACL. Click << Remove to remove the trustpoint from the selected list.
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Viewing Associated Trustpoints

To view the Trustpoints associated with a Certificate ACL:

Step 1 Click Setup at the top of the window, click PKI in the left-most pane, and select
Trustpoints > Certificate ACLs from the object selector.

Step2  Select a Certificate Map from the table. The Certificate ACL details appear at the
lower section of the content window.

Step3  Select a sequence from the sequence list, then click View Associated
Trustpoints.

The following details appear for the associated Trustpoints:

Field Description

Trustpoint Name The trustpoint associated with the
Certificate ACL.

CA Name The CA name of the associated
trustpoint.

Subject Name The subject of the associated
trustpoint.

Adding Certificate ACL

Step 1 Click Setup at the top of the window, click PKI in the left-most pane, and select
Trustpoints > Certificate ACLs from the object selector. The Certificate ACLs
page appears.

Step2  Click Add. The Add Certificate ACL dialog box appears.
Using this dialog box you can:
¢ Add a new ACL entry

e Remove an existing ACL entry

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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M Adding Certificate ACL

e Add new criteria to an existing ACL entry

e Remove criteria from an existing ACL entry.

The dialog box displays following fields:

Field

Action/Description

Certificate ACL Name

Name or Tag associated with the
Certificate Map.

Certificate ACL Entries and Criteria

Certificate ACL Entry

To add a new ACL Entry, enter the
ACL sequence number in the New
ACL Entry field, then click >> Add.

To remove an ACL Entry, select the
ACL entry from the sequence list, then
click << Remove.

Sequence

The sequence number of the ACL
entry.

Valid range is from 1 to 65535.

Certificate Field

Select one of the following certificate
field to be examined for Access
Control:

e Subject Name

e Alternate Subject Name

e Any subject name field

e Unstructured subject name
e Issuer name

e Valid start date

e Expiry date
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Step 3

Editing Certificate ACLs

Field Action/Description
Match Condition The following match conditions are
supported:

e Equals (eq)

e Not Equals (neq)

e Contains (co)

¢ Not Contains (nco)

e Less than (It)

e Greater than or Equals (ge)

Match Value Certificate Field value

To add new criteria to the ACL entry, select a certificate field and match
condition, then enter the match value and click Add. The values you entered
appears in the table. To remove a criteria from the ACL entry, select a row in the
table, then click Remove.

Click OK to complete the task.

Editing Certificate ACLs

Step 1

Step 2

Click Setup at the top of the window, click PKI in the left-most pane, and select
Trustpoints > Certificate ACLs from the object selector. The Certificate ACLs
page appears.

Select a Certificate ACL from the list, then click Edit. The Edit Certificate Map
dialog box appears.

Using this dialog box you can:
e Add a new ACL entry
e Remove an existing ACL entry
e Add new criteria to an existing ACL entry

e Remove criteria from an existing ACL entry.

| oL-6014-02
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W Editing Certificate ACLs

The page displays following fields:

Field

Description

Certificate ACL Name

Name associated to the Certificate
ACL

Certificate ACL Entries and Criteria

Certificate ACL Entry

To add a new ACL Entry, enter the
ACL sequence number in the New
ACL Entry field, then click ADD.

To remove an ACL Entry, select the
ACL entry from the sequence list, then
click Remove.

Sequence

The sequence number of the ACL
entry.

Valid range is from 1 to 65535.

Certificate Field

Select one of the following certificate
field to be examined for Access
Control:

e Subject Name

e Alternate Subject Name

e Any subject name field

e Unstructured subject name
e Issuer name

e Valid start date

e Expiry date
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Deleting Certificate ACLs

Field Description
Match Condition The following match conditions are
supported:

e Equals (eq)

e Not Equals (neq)

e Contains (co)

¢ Not Contains (nco)

e Less than (It)

e Greater than or Equals (ge)

Match Value Certificate Field value

To add new criteria to the ACL entry, select a certificate field and match
condition, then enter the match value and click Add. The values you entered
appears in the table. To remove a criteria from the ACL entry, select a row in the
table, then click Remove.

Step3  Click OK to add the certificate ACL.

Deleting Certificate ACLs

Step1  Click Setup at the top of the window, click PKI in the left-most pane, and select
Trustpoints > Certificate ACLs from the object selector. The Certificate ACLs
page appears.

Step2  Select a certificate ACL, then click Delete.
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W Deleting Certificate ACLs

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
m. oL-6014-02 |




CHAPTER 7

Managing Proxy Services

CVDM-SSLSM allows you to view, configure, and edit Proxy Services. The
Proxy Service Wizards helps you set up proxy services.

This chapter contains the following topics:
e Proxy Service Wizards, page 7-2
e Viewing Proxy Services, page 7-15
e Viewing Proxy Services Details, page 7-18
e Troubleshooting Proxy Services, page 7-33
e NAT Pools, page 7-26

You can configure the virtual IP address and port associated with the proxy
service, and the associated target server IP address and port. You can define TCP
and SSL policies for both client (virtual) and server sides of the proxy.

You can configure SSL client proxy services to specify that the proxy service
accepts clear text traffic, encrypts the traffic into SSL traffic, and forwards the
traffic to the backend SSL server.

While you are required to configure a certificate for the SSL server proxy, you are
not required to configure a certificate for SSL client proxy. If you configure the
certificate for the SSL client proxy, that certificate is sent in response to the
Certificate Request message that is sent by the server during the client
authentication phase of the handshake protocol.

| oL-6014-02
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W Proxy Service Wizards

Proxy Service Wizards

CVDM-SSLSM supports the following proxy service wizards. You can use the
basic Proxy Service Wizard to configure a proxy service and assign a certificate.
The advanced proxy service wizards helps you to configure the proxy service,
assign a certificate and policies, and configure peer certificate authentication.

e Basic Proxy Service Wizard, page 7-3
¢ Advanced Proxy Service Wizard, page 7-8

Figure 7-1 Proxy Service Wizards

& CiscoView Device Manager for 65L5M - 10.77.241.10 =13l x|
Fle Edt WView Hslp
& oy Cisco SysTEus
Hame Setup ‘ Refiesh  Delier Help
Setup
- Certificate Wizards Proxy Service Wizards |

Provey Service Wizard will guide you to setup proxy services.
You can do the follovwing tasks:

(+ Basic Proxy Service Wizard

Configure & proxy service, and assign a cerificate

" advanced Proxy Service Wizard

Configure & proxy service, assign certificate and policies,
and configure cerificate authentication.

Launch the Selected Task

113573

<lab= [<15= |§ |Mon My 03 10:47:20 POT 2004

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
m. oL-6014-02 |




| Chapter?

Managing Proxy Services

Proxy Service Wizards Il

Basic Proxy Service Wizard

Step 1
Step 2
Step 3
Step 4

Step 5

Step 1

Step 2

Step 3

The Basic Proxy Service wizard helps you set up a server proxy service or a client
proxy/backend encryption service.

To launch the basic proxy service wizard:

Click Setup in the task bar.
Click Wizards in the left-most pane. The Wizards page appears.
Click Proxy Services Wizard tab. The Proxy services wizard page appears.

Select Basic Proxy Service Configuration, then click Launch the Selected Task
The Welcome page for basic proxy service wizard appears.

The Welcome page describes the steps to follow for creating a proxy service.
Click Next to continue.

To create a proxy service:

Define the proxy service name and type. For more information on defining the
name and type, see Defining Proxy Service Name and Type, page 7-4.

Configure the client side (virtual) parameters and server parameters. For more
information on configuring the client side (virtual) parameters and the server
parameters, see Configuring Client Side (Virtual) and Server Parameters,
page 7-5.

Assign certificate to proxy service (optional for client proxy service). For more
information on assigning certificates to a proxy service, see Assigning Certificate
to Proxy Services, page 7-6.
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Defining Proxy Service Name and Type

This page of the basic proxy service setup wizard helps you define the name and

type of the proxy service.

The following fields appear:

Field

Description

Proxy Service Name

Enter a name for your proxy service.

Admin Status

Select the admin status of the proxy service.

Values are:
° Up
e Down

Service Type

Server Proxy

Select this option if you want to create a server proxy
service.

Server proxy service accepts clear text traffic,
encrypts the traffic into SSL traffic, and forwards it to
the backend SSL Server.

Client Proxy / Backend
Encryption

Select this option if you want to create a client proxy
service.

Client server proxy service accepts SSL traffic,
decrypts the traffic into clear text, and forwards it to
the backend server or virtual server.

Click < Back to read the welcome page.

Click Next > to move to step 2 of the task.
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Proxy Service Wizards

Configuring Client Side (Virtual) and Server Parameters

This page of the basic proxy setup wizard helps you in configuring the client side
parameters and server parameters. You can configure NAT and also enable SSL
Version 2.0 connections to be forwarded to a server using this page.

The following fields appear:

Field

Description

Client Side (Virtual)

Virtual IP Address

Enter the virtual IP address.

Secondary

Select the checkbox if you want to use the IP address
as a secondary IP address.

Virtual IP Mask

Select any one of the following netmasks:
e 0.0.0.0
e 255.0.0.0
e 255.255.0.0
e 255.255.255.0

Wildcard Virtual IP
Address

Select the checkbox to configure a wildcard virtual IP
address.

Port (1-65535)

Enter the number of the port to be used for proxy
service traffic.

Server

Server IP Address Enter the server IP address.

Port (1-65535) Enter the number of the port to be used for the traffic.
NAT

Server NAT Select the check-box if you want to use a Server NAT.
Client NAT Select the check-box if you want to use a Server NAT.
Client NAT Pool Select any of the following options:

e Create and assign a new NAT Pool.

e Select an existing NAT Pool.

¢ Clear the NAT pool.
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Field Description

Forward SSL version Select the check-box if you want to forward SSL

2.0 Connections version 2.0 connection to a SSLv2 server.

Server IP Address The IP address of the server to be used for SSL
version 2.0.

Port (1-65535) The port to be used for the traffic.

Click < Back to move back to Step 1 of the basic setup wizard.

Click Next > to move to step 3 of the basic setup wizard.

Assigning Certificate to Proxy Services

This page of the Basic Proxy Service setup wizard helps you assign a certificate
to the proxy service.

The following fields are displayed:

Field Description

Certificate

Certificate Trustpoint Select one of the following options:

e Select an existing Trustpoint.

e (lear the Trustpoint.

Status Displays the status of the certificate.
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Proxy Service Wizards Il

Selecting Available Certificate Trustpoints

The available certificate Trustpoints dialog box provides information on the
certificate Trustpoints available for the proxy services.

The following fields appear:

Field Description

Trustpoint The name of the Trustpoint.

Certificate Authority The certification authority details of the certificate
(CA) Trustpoint.

Subject The subject of the certificate Trustpoint.

Select a Trustpoint, then click OK to select an existing certificate Trustpoint.

Viewing Proxy Service Setup Summary
From this window you can view a summary of the configured settings. You can
review the configuration information.
Click < Back to move to the previous page of the wizard.

Click Finish to complete the setting up of proxy service.
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Advanced Proxy Service Wizard

Step 1
Step 2
Step 3
Step 4

Step 5

Step 1
Step 2
Step 3
Step 4

The Advanced Proxy Service wizard helps you in setting up a server proxy service
or a client proxy/backend encryption service, and allows you to configure
certificate authentication. The wizards also helps you set up policies for client
(virtual) side and server connections.

To launch the advanced proxy service wizard:

Click Setup in the task bar.
Click Wizards in the left-most pane. The Wizards page appears.
Click Proxy Services Wizard tab. The Proxy services wizard page appears.

Select Advanced Proxy Service Configuration, then click Launch the Selected
Task The Welcome page of the basic proxy service wizard appears.

The Welcome page describes the steps to follow for creating a proxy service.
Click Next to continue.

To create a proxy service:

Define Proxy Service Name and Type.
Configure Client Side (Virtual) and Server Parameters.
(Optional for client proxy service) Assign Certificate to Proxy Service.

(Optional) Assign policies to proxy service.
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Defining Proxy Service Name and Type

This page of the Advanced Proxy Service setup wizard helps you in defining
proxy service name and type.

The following fields appear:

Field

Description

Proxy Service Name

Enter a name for your proxy service.

Admin Status

Select the admin status of the proxy service.

Values are:
° Up
e Down

Service Type

Server Proxy

Select this option if you want to create a server proxy
service.

Server proxy service accepts clear text traffic,
encrypts the traffic into SSL traffic, and forwards it to
the backend SSL Server.

Client Proxy / Backend
Encryption

Select this if option if you want to create a Client
proxy service.

Client server proxy service accepts SSL traffic,
decrypts the traffic into clear text, and forwards it to
the backend server or virtual server.
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Configuring Client Side (Virtual) and Server Parameters

This page of the advanced proxy setup wizard helps you in configuring the client
side parameters and server parameters. You can configure NAT using this page
and also enable SSL Version 2.0 connections to be forwarded to a server.

The following fields appear:

Field

Description

Client Side (Virtual)

Virtual IP Address

Enter the virtual IP address.

Secondary

Select the check-box if you want to make the sever
secondary.

Virtual Netmask

Select any one of the following netmasks:

e 0.0.0.0
e 255.0.0.0
e 255.255.0.0

e 255.255.255.0

Wildcard Virtual IP
Address

Select this checkbox to configure a wildcard virtual IP
address.

Port (1-65535)

Enter the number of the port to be used for proxy
service traffic.

Server

Server IP Address Enter the server IP address.

Port (1-65535) Enter the number of the port to be used for the traffic.
NAT

Server NAT Select the checkbox if you want to use a server NAT.
Client NAT Pool Click %:- | and select any of the following options:

e Create and assign a new NAT Pool.

e Select an existing NAT Pool.

e Clear the NAT pool.
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Click < Back to move back to Step 1 of the basic setup wizard.

Click Next > to move to step 3 of the basic setup wizard.

Assigning Certificate to Proxy Service

Assigning Policies to Proxy Services

This page of the advanced proxy setup wizard helps you in assigning a certificate

to the proxy service.

The following fields appear:

Field Description
Certificate
Certificate Trustpoint Click %:- | and select one of the following options:

e Select an existing Trustpoint.

e (lear the Trustpoint.

Status

Displays the status of the certificate.

Peer Certificate Authentication

Certificate
Authentication

Enable or disable the certificate authentication.

Trusted CA Pool

The name of the trusted CA Pool.

This page of the wizard helps you to assign policies to virtual and server proxy

services.

The following fields appear:

Field Description

Client Side (Virtual) Select a client side TCP policy.
TCP Policy

Client Side (Virtual) Select a client side SSL policy.
SSL Policy

Server TCP Policy

Select a server TCP policy.
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Field

Description

Server SSL Policy

Select a server SSL policy.

URL Rewrite Policy

Select a URL rewrite policy.

HTTP Header Insertion
Policy

Select an HTTP header insertion policy.

The dialog box helps you to:

¢ Create and use a new policy.

e Select an existing policy. You can select a policy from the list of existing

policies.

e Clear the policy.

Assigning TCP Policy to Proxy Services

This page of the wizard helps you to assign policies to virtual and server proxy

services.

The following fields appear:

Field

Action/Description

Policy

The name of the TCP Policy.

Proxy Service Name

The name of the proxy service.

Client Side (Virtual)

The name of the client side server.

Selected Services

The list of selected services.

Side

Select one of the following:

Both-the policy is assigned to both
server and client.

Client-the policy is assigned to client
only.

Server-the policy is assigned to server
only.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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To assign a policy:

Step1  Select a proxy service name from the table, then click Add>>. The proxy service
name is added to the list of selected services.

Step2  Select the side to which the policy has to be assigned.
Step3  Click OK.

Viewing Advanced Proxy Service Setup Summary
The summary page of the Advanced Proxy Service setup wizard provides the
details of the proxy service you have configured.
Click < Back to move to step 3 of the wizard.

Click Finish to complete the setting up of proxy service.

Selecting Available NAT Pools

The Available NAT Pools dialog box provides information on the NAT Pools
configured on the SSLSM.

Select a NAT Pool from the list, then click OK to select a NAT Pool.
The following fields appear:

Field Description

Name Name of the NAT pool.

Start IP Address The first IP address in the NAT pool.

End IP Address The last IP address in the NAT pool.

Netmask The Netmask used by the addresses in the NAT pool.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Selecting Available CA Pools

The Available CA Pools dialog box provides information on the CA Pools
configured on the SSLSM.

Select a CA Pool from the list, then click OK to select a CA Pool.
The following fields appear:

Field Description

Name The name of the CA Pool.

Number of Trustpoints |The number of Trustpoints associated to each CA
Pool.

Status The status of the CA Pool.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Viewing Proxy Services

Figure 7-2 Proxy Services
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To view proxy services:

Step 1 Click Setup from the task bar.
Step2  Click Proxy Services. The proxy services page appears.

Step3  Open Proxy Services Group Folder. Proxy services are grouped under two
sub-group folders:

e Server Proxy Services

e Client Proxy Services

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Step4  Click any of the sub-group folder.
The following fields appear:

Field Description

Proxy Services

Name Name of the proxy service.

Type The type of the proxy service.

Client Side The IP address and port number of the client.
Server The IP address and port number of the server.
Admin Status The admin status of the service.

Oper Status Indicates the operational status of the service.

A & icon indicates that the service is
administratively down.

A & icon indicates that the service is operationally
down.

A & icon indicates that the service is up.

Certificate Indicates the status of the certificate.
A [ icon indicates that the certificate is valid.
A icon indicates that the certificate invalid.

A icon indicates that the certificate is valid only
for less than 10 days.

A icon indicates that the certificate is valid only
for less than 20 days.

A icon indicates that the certificate is valid only
for less than 30 days.

A % icon indicates that the certificate chain is
complete.

A ﬁ icon indicates that the certificate chain is
incomplete.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Select any of the proxy service from the table, the following information appears

for the selected service:

Proxy Service Status Details

Field

Description

Proxy Service

Name of the proxy service.

General

Service Type

The type of the service provided by the proxy.

For example: Server Proxy

Client Side

The IP address and port number of the client.

Server

The IP address and port number of the server.

Operation Status

Indicates the operational status of the service.

Client NAT Indicates whether the client NAT is enabled.

Server NAT Indicates whether the server NAT is enabled.
Server/Client Indicates whether the peer certificate authentication is
Certificate enabled.

Authentication

Certificate

Trustpoint Name of the certificate Trustpoint associated with the

proxy service.

Subject Name

The subject name of the associated certificate.

CA Name

The issuer name of the associated certificate.

Key Pair

The key pair name, key size and indicates whether key
pair is exportable.

Certificate Status

Indicates the validity of the certificate.

Certificate Chain

Indicates the status of the certificate chain.
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User Guide for CiscoView Device Manager for the Cisco SSL Services Module g



Chapter7  Managing Proxy Services |

M Viewing Proxy Services Details

Viewing Proxy Services Details

Figure 7-3 Proxy Service Details
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To view the configured proxy services:

Step 1 Click Setup from the task bar.
Step2  Click Proxy Services. The proxy services page appears.

Step3  Open Proxy Services Group Folder. Proxy services are grouped under two
sub-group folders:

e Server Proxy
e C(Client Proxy

Step4  Open any of the sub-group folder, then click any of the object in the sub-group
folder.
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You can also view the details by clicking the proxy service hyperlink in the proxy

service status details panel

The following fields appear:

Field Description

Configuration

Proxy Service Name Name of the proxy service

Admin Status The administrative status of the proxy service.

Service Type The type of the proxy service handled by the proxy
service.

Operation Status The operation status of the proxy service.

Client Side (Virtual)

Virtual IP Address The client side IP address of the proxy service.

Virtual IP Mask The client side mask used by the proxy service.

Port The TCP port used by the client side proxy service.

Server

IP Address The server IP address used by the proxy service.

Port The TCP port used by the server side proxy service.

NAT

Server NAT Indicates whether the server NAT is enabled.

Client NAT Indicates whether the client NAT is enabled.

Client NAT Pool The client NAT Pool used by the proxy service.

SSLV2 Server

IP Address The IP address of the SSLV2 server used by the
service.

Port The port used by the SSLv2 server.

Certificate

Certificate Trustpoint The name of the certificate Trustpoint associated by
the service.

Trusted CA Pool The name of the trusted CA pool used by the service.

| oL-6014-02
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Field Description

Server/Client Indicates whether a peer certificate authentication is
Certificate being used.

Authentication

Policy

Client Side (Virtual) The virtual TCP policy used by the service.

TCP Policy

Client Side (Virtual) The virtual SSL policy used by the service.

SSL Policy

Server TCP Policy The server TCP Policy used by the service.

URL Rewrite Policy The URL rewrite policy used by the service.

HTTP Header Insertion |The HTTP header insertion policy used by the service.

Policy

Click Certificate Details Tab to view the Certificate details.

Field Description
Certificate Status The status of the certificate used by the selected
service.

+05:30 2004

Example: Valid until Tue Nov 02 04:22:11 GMT

Trusted CA Certificates

CA Name The name of the CA associated with the service.

Certificate Status The status of the certificate.

Associated Trustpoint | Trustpoints associated with the certificate.

Click Certificate Chain Tab to view the Certificate chain.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Field

Description

Status

The status of the certificate chain.

Example: Certificate chain is complete.

Certificate Details

Certificate

and the certificate.

+05:30 2004

Displays the time until which the certificate is valid

Example: Valid until Tue Nov 02 04:22:11 GMT

Associated Trustpoints

associated Trustpoint.

This field appears only if the certificate has an
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Click Policy Details Tab to view the Certificate chain.

Field Description

Policies The list of applicable policies.

e Client Side (Virtual) SSL policy
e Client Side (Virtual) TCP policy
e Server TCP Policy

e URL Rewrite Policy

e HTTP Header Insertion policy

Select any of the policies to view the details.

Policy Details The content in the policy details area changes
according to the policies you select.

Editing Proxy Service Configuration

Step1  Click Setup from the task bar.
Step2  Click Proxy Services. The proxy services page appears.

Step3  Open Proxy Services Group Folder. Proxy services are grouped under two
sub-group folders:

e Server Proxy Services
¢ Client Proxy Services

Step4  Open any of the sub-group folder, then click any of the object in the sub-group
folder. The proxy service details page appears.

Step5  Click Edit....

The following information appears:

Field Action/Description
Proxy Service Name Name of the proxy service you are editing.
Admin Status Select the admin status for the service.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Field

Action/Description

Client Side (Virtual)

Virtual IP Address

Enter the virtual IP address for the service.

Secondary

Select the checkbox if you need to make the virtual IP
address a secondary IP address.

Secondary is required if the IP address is not on a
directly connected network.

Virtual IP Mask

Select wildcard virtual IP address option to make this
field active.

Select the IP mask from the drop-down list.

Wildcard Virtual IP
Address

Select this option to use wildcard IP address.

Port (1-65535)

Enter the port number to be used by the service.

Server

IP Address

Enter the server IP address.

Port (1-65535)

Enter the port number used by the server.

SSLV2 Server

IP Address Enter the IP address of the SSLV2 server.

Port (1-65535) Enter the port number to be used by the server.
NAT

Server NAT Select this option to use a server NAT.

Client NAT Select this option to use a server NAT.

Client NAT Pool

Select one of the following:
e Create and use a new NAT Pool

e Select an existing NAT Pool

e C(Clear the NAT Pool

To edit the certificate details of the service, click Certificate tab. The following

fields appear:

| oL-6014-02
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Field

Action/Description

Certificate Trustpoint

Select any of the following options:
e Select an existing Trustpoint

¢ Clear the Trustpoint

Trusted CA Pool

Select any of the following options:
¢ Create and use a new CA Pool
e Select an existing CA Pool

e (Clear the CA Pool

Client/Server
Certificate
Authentication

Select any of the following options:
¢ Disabled

e Verify Signature, Check CRL and Certificate
ACL

e Verify Signature Only

To edit the policy details of the service, click Policy tab. The following fields

appear:

Field

Action/Description

Client Side (Virtual)
TCP Policy

Select any of the following:
¢ Create and use a new TCP Policy
e Select an existing TCP Policy
e Clear TCP Policy

Client Side (Virtual)
SSL Policy

Select any of the following:
e Create and use a new SSL Policy
e Select an existing SSL Policy
e Clear SSL Policy

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Field

Action/Description

Server TCP Policy

Select any of the following:

Create and use a new TCP Policy
Select an existing TCP Policy
Clear TCP Policy

Server SSL Policy

Select any of the following:

Create and use a new SSL Policy
Select an existing SSL Policy
Clear SSL Policy

URL Rewrite Policy

Select any of the following:

Create and use a new URL Rewrite Policy
Select an existing URL Rewrite Policy
Clear URL Rewrite Policy

HTTP Header Insertion
Policy

Select any of the following:

Create and use a new HTTP Header Insertion
Policy

Select an existing HTTP Header Insertion Policy
Clear HTTP Header Insertion Policy
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NAT Pools

CVDM-SSLSM allows you to create Network Address Translation (NAT) pools.

Figure 7-5 NAT Pools
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This section describes the following topics:
e Viewing NAT Pools, page 7-28
e Adding NAT Pools, page 7-29
e Deleting NAT Pools, page 7-30
e Assigning NAT Pools to Proxy Services, page 7-30
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Understanding NAT Pools

Server NAT

Client NAT

Client connections originate from the client and are terminated on the SSL
Services Module. Server connections originate from the SSL Services Module.

You can configure client NAT, server NAT, or both, on the server connection.

If you configure server NAT, the server IP address is used as the destination IP
address for the server connection. If the server NAT is not configured, the
destination IP address for the server connection is the same as the virtual IP
address for which SSL Services Module is a proxy.

If you configure client NAT, the server connection source IP address and port are
derived from a NAT pool. If client NAT is not configured, the server connection
source IP address and port are derived from the source IP address and source port
of the client connection.

Allocate enough IP addresses to satisfy the total number of connections supported
by the SSL Services Module (256,000 connections). Assuming you have 32,000
ports per IP address, configure 8 IP addresses in the NAT pool. If you try to
configure fewer IP addresses than required by the total connections supported by
the SSL Services Module, the command is rejected.
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Viewing NAT Pools

Step1  Click Setup in the task bar.
Step2  Click Proxy Services in the left-most pane. The Proxy Services page appears.
Step3  Click NAT Pools in the object selector.

The following information appears:

Field Description
Name The Name of the NAT Pool.
Start IP Address The first IP address used by the NAT Pool.
End IP Address The last IP address used by the NAT Pool.
Netmask The netmask used for the NAT pool.

For example: 255.255.0.0
Use Count Number of proxy services using the NAT pool.

Select a NAT Pool, then click Assign to Proxy Services to assign a NAT Pool to
a proxy service

Click Add... to add a new NAT Pool.
Select a NAT Pool, then click Delete to delete a NAT Pool.
Stepd  Select any NAT Pool from the table to display the configuration details.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Field Description

General

Start IP Address The first IP address in the NAT pool.
End IP Address The last IP address in the NAT pool.
Netmask The netmask used for the NAT pool.

For example: 255.255.255.0

Associated VLAN

The VLAN associated with the NAT pool.

Use Count

The number of proxy services associated with the
NAT Pool.

Associated Proxy Services

Name The name of the associated proxy service.
Client Side The IP address of the virtual server.
Server The IP address of the server.

Adding NAT Pools

Step1  Click Setup in the task bar.

Step2  Click Proxy Services in the left-most pane. The Proxy Services page appears.
Step3  Click NAT Pools in the object selector.
Step4  Click Add.... The Add New NAT Pool dialog box appears.

Field

Description

NAT Pool Name

Enter a name for your new NAT Pool.

Start IP Address

Enter the first IP address to be used for the NAT Pool.

End IP Address

Enter the last IP address to be used for the NAT Pool.

Net Mask

The IP mask to be used by the NAT Pool.
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Alternatively, you can add NAT Pools using the Wizards.

Deleting NAT Pools

Step1  Click Setup in the task bar.

Step2  Click Proxy Services in the left-most pane. The Proxy Services page appears.
Step3  Click NAT Pools in the object selector.

Step 4 Select a NAT pool from the list, then click Delete.

Assigning NAT Pools to Proxy Services

Step 1 Click Setup in the task bar.
Step2  Click Proxy Services in the left-most pane. The Proxy Services page appears.
Step3  Click NAT Pools in the object selector.

Step4d  Select a NAT pool from the list, then click Assign to Proxy Services. The Assign
NAT Pool to Proxy Services dialog box appears.

Field Description
Pool Name The name of the NAT Pool you have selected.
Proxy Service Name The name of the proxy service. You can select any one

of the service from the list.

Client Side (Virtual) Virtual server associated with the proxy service.

Selected Proxy Services |The list of services to which you want to assign the
NAT Pool.

Step5  Select a Proxy Service Name, then click Add >> to add the policy to the selected
service.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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You can remove the a proxy service from the list. Select a service from the list,
then click << Remove.

You can clear all the services selected for assigning to a policy. Select a service
from the list, then click Clear All.

Step6  Click OK to assign NAT pool to the selected proxy services.

Selecting Available CA Pools

The following information appears:

Field Action/Description

Name Name of the CA Pool.

Number of Trustpoints Number of Trustpoints associated with
the CA Pool.

Status Indicates the status of the CA Pool.

Select a CA Pool from the table, then click OK.

Selecting Available NAT Pools

The following information appears:

Field Action/Description

Pool Name Name of the NAT pool.

Start IP Address The start IP address of the pool.

End IP Address The end IP address of the pool.

Netmask The netmask and port used by the
selected NAT pool.

Select a NAT Pool from the table, then click OK.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Selecting Available Certificate Trustpoints

The following information appears:

Field Action/Description

Trustpoint The name of the Trustpoint.

Certificate Authority (CA) The certificate authority details in the
certificate.

Subject The subject in the certificate.

Select a Certificate Trustpoint from the table, then click OK.

How Do I...

This section describes on how to achieve a task. The following question is
answered:

e How Do I Setup a Proxy Service?

How Do | Setup a Proxy Service?

You can use Proxy Service Setup Wizards to create a proxy service.

The Basic Proxy Service wizard helps you set up a server proxy service or a client
proxy/backend encryption service.

Step1  Click Setup in the task bar.
Step2  Click Wizards in the left-most pane. The Wizards page appears.
Step3  Click Proxy Services Wizard tab. The Proxy services wizard page appears.

Step4  Select Basic Proxy Service Configuration, then click Launch the Selected Task
The Welcome page for basic proxy service wizard appears. The Welcome page
describes the steps to follow to complete the task.

Step5  Click Next to continue.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Step 7
Step 8

Step 9
Step 10

Troubleshooting Proxy Services W

Define the proxy service name and type. For more information on defining the
name and type, see Defining Proxy Service Name and Type, page 7-4

Click Next to continue.

Configure the client side (virtual) parameters and server parameters. For more
information on configuring the client side (virtual) parameters and the server
parameters, see Configuring Client Side (Virtual) and Server Parameters,
page 7-5.

Click Next to Continue.

Assign certificate to proxy service (optional for client proxy service). For more
information on assigning certificates to a proxy service, see Assigning Certificate
to Proxy Services, page 7-6.

Troubleshooting Proxy Services

This section describes the proxy service operations status and the possible cause.

Proxy Service Operation Status Possible Cause/Action

No cert The certificate Trustpoint associated
with the proxy service does not have a
valid certificate or the certificate chain
is incomplete.

You must make sure that the Trustpoint
has a valid certificate and that the
certificate chain is complete.

No Virtual IP Virtual IP address has not been
configured for the proxy service.

No Server IP Server IP address has not been
configured for the proxy service.
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Proxy Service Operation Status Possible Cause/Action

Cert not configured No certificate has been configured for
the proxy service. You must assign a
certificate for server proxy service. For
client proxy service a certificate is
optional.

No CA pool If you have enabled peer certificate
authentication to verify all (signature,
CRL check and ACL check), you must
configure a CA pool with valid CA
certificates for the proxy service.
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Proxy Service Operation Status

Possible Cause/Action

No connectivity

No Client VLAN

If the virtual IP address (VIP) is not
secondary, you must configure a
VLAN for the client side network.

If you configure the VIP as secondary,
it does not have to be in the VLAN
(subnet) connected to the SSL Services
Module.

No Server VLAN

If the server is in a network that is
directly connected to SSL Services
Module, you must configure a VLAN
for the server side network.

If the server is not in a directly
connected network, you must
configure a route to the server.

No SSLv2 Server VLAN

If you have enabled forwarding of
SSLv2 connections to a server and if
the SSLv2 server is in a directly
connected network, you must
configure a VLAN for the server side
network.

If the SSLv2 server is not in a directly
connected network, you must
configure a route the SSLv2 server.

No Server/Next Hop MAC

The server or the next hop (gateway) to
the server is not responding to ARP.

No SSLv2 Server/Next Hop MAC

The SSLv2 server or the next hop
(gateway) to the SSLv2 server is not
responding to ARP.

| oL-6014-02
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M Troubleshooting Proxy Services
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CHAPTER

Managing Policies

The CVDM-SSLSM supports defining policies for Proxy Services. The policy
templates help the Administrator customize the attributes associated with SSL
and TCP stack to suit the needs.

The following policies are supported by the SSLSM:
e SSL Policy, page 8-10
e TCP Policy, page 8-3
e HTTP Header Insertion Policy, page 8-17
e URL Rewrite Policy, page 8-23

Policies are grouped by their type and are displayed as a tree node in the object
selector. All configured policies of a type are listed as child nodes under the policy
node.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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The TCP commands for the SSL Services Module apply either globally or to a
particular proxy server.

The TCP policy template allows you to define parameters associated with the TCP
stack.

Viewing TCP Policies

Step 1
Step 2

Step 3

To view the TCP Polices:

Click Setup from the task bar.

Click Policies from the left-most pane, then select TCP Policy from the object
selector. The policy information appears on the page.

The following fields appear:

TCP Policies
Fields Description
Policy Name Name of the TCP Policy

Number of Proxy Services (Use Count) |Number of proxy services using the
TCP Policy.

Select a policy, then click Assign to Proxy Services to assign a policy to the
proxy services.

Click Add to add a new TCP policy. The Add TCP Policy dialog box appears.

Select a policy, then click Edit to edit a TCP policy. The Edit TCP Policy dialog
box appears.

Select a policy, then click Delete to delete the policy.

Select a policy from the TCP Policy table, then click Policy Tab to view the policy
details or click Associated Proxy Services tab to view the proxy services
associated with the policies.

TCP Policy Details

| oL-6014-02
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Fields Description

Policy

Policy Name Name of the TCP Policy.

MSS The maximum segment size (MSS), in

bytes, that the connection will identify
in the SYN packet that it generates.

Syn Timeout The connection establishment timeout.

Inactivity Timeout The amount of time, in seconds, that an
established connection can be inactive.

Reassembly Timeout The amount of time, in seconds, before
the reassembly queue is cleared. If the
transaction is not complete within the
specified time, the reassembly queue is
cleared and the connection is dropped.

Fin Timeout The FIN wait timeout in seconds.

Buffer Share Rx The maximum receive buffer share per
connection in bytes.

Buffer Share Tx The maximum transmit buffer share
per connection in bytes.

Associated Proxy Services

Name The name of the associated proxy
service.

Type Type of the proxy service.

Side Indicates whether the policy is applied

to the client side or server side of the
proxy service.

Virtual Server The IP address of the virtual server.

Server The IP address of the server.

Oper Status The operational status of the proxy
Server.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Fields Description
Status The status of the proxy server.
Certificate Status of the certificate associated with
the proxy service.

Assigning Policies to Proxy Services

Step 1 Click Setup from the task bar.

Step2  Click Policies from the left-most pane, then select a Policy from the object
selector. The policy information appears on the page.

Step3  Select a policy from the Policies table, then click Assign to Proxy Services.

The Assign Policy to Proxy Services dialog box appears with the following

details:

Field Description

Policy The name of the selected policy.

Proxy Service Name Name of the proxy service.

Client Side (Virtual) Name of the virtual server configured
for the proxy service.

Selected Services The list of services to which the policy
is associated. The list appear only after
adding proxy services for the policies.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Figure 8-2 Assigning Policies to Proxy Service
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Select a Proxy Service Name, then click Add >> to add the policy to the selected
service.

You can remove the a proxy service from the list. Select a service from the list,
then click << Remove.

You can clear all the services selected for assigning to a policy. Select a service
from the list, then click Clear All.

Click OK to complete the task.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Adding TCP Policy

Step 1
Step 2

Step 3

Click Setup from the task bar.

Click Policies from the left-most pane, then select TCP Policy from the object
selector. The policy information appears on the page.

Click Add. The Add TCP Policy dialog box appears.

Field Description

Policy

Policy Name Enter a name for the TCP Policy.
MSS Enter the maximum segment size

(MSS), in bytes, that the connection
will identify in the SYN packet that it
generates.

The default is 1460 bytes. The valid
range is from 256 to 2460 bytes.

Timers

Syn Timeout Enter the connection establishment
timeout. The default is 75 seconds. The
valid range is from 5 to 75 seconds.

Inactivity Timeout Enter the amount of time, in seconds,
that an established connection can be
inactive. The default is 600 seconds.
The valid range is 0 to 960 seconds (0
= disabled).

Reassembly Timeout Enter the amount of time, in seconds,
before the reassembly queue is cleared.
If the transaction is not complete
within the specified time, the
reassembly queue is cleared and the
connection is dropped. The default is
60 seconds. The valid range is 0 to 960
seconds (0 = disabled).

| oL-6014-02
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Field Description

Fin-wait Timeout Enter the FIN wait timeout in seconds.
The default value is 600 seconds. The
valid range is from 75 to 600 seconds.

Buffer Share Enter the maximum receive buffer
share per connection in bytes. The
default value is 32768 bytes. The valid
range is from 8192 to 262144 bytes.

Buffer Share Rx Enter the maximum transmit buffer
share per connection in bytes. The
default value is 32768 bytes. The valid
range is from 8192 to 262144 bytes.

Step4  Click OK to add the new TCP Policy.

Editing TCP Policy

Step1  Click Setup from the task bar.

Step2  Click Policies from the left-most pane, then select TCP Policy from the object
selector. The policy information appears on the page.

Step3  Click Edit. The Add TCP Policy dialog box appears.

Field Description

Policy

Policy Name Name of the TCP Policy

MSS Modify the maximum segment size

(MSS), in bytes, that the connection
will identify in the SYN packet that it
generates.

The default is 1460 bytes. The valid
range is from 256 to 2460 bytes.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Field Description
Timers
Syn Timeout Modify the connection establishment

timeout. The defaultis 75 seconds. The
valid range is from 5 to 75 seconds.

Inactivity Timeout Enter the amount of time, in seconds,
that an established connection can be
inactive. The default is 600 seconds.
The valid range is 0 to 960 seconds (0
= disabled).

Reassembly Timeout Enter the amount of time, in seconds,
before the reassembly queue is cleared.
If the transaction is not complete
within the specified time, the
reassembly queue is cleared and the
connection is dropped. The default is
60 seconds. The valid range is 0 to 960
seconds (0 = disabled).

Fin-wait Timeout Enter the FIN wait timeout in seconds.
The default value is 600 seconds. The
valid range is from 75 to 600 seconds.

Buffer Share Enter the maximum receive buffer
share per connection in bytes. The
default value is 32768 bytes. The valid
range is from 8192 to 262144 bytes.

Buffer Share Rx Enter the maximum transmit buffer
share per connection in bytes. The
default value is 32768 bytes. The valid
range is from 8192 to 262144 bytes.

Step4  Click OK to save the new configuration for the TCP policy.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Deleting TCP Policy

Step1  Click Setup from the task bar.

Step2  Click Policies from the left-most pane, then select TCP Policy from the object
selector. The policy information appears on the page.

Step 3 Select a Policy from the list, then click Delete.

SSL Policy

The SSL policy option allows you to define parameters associated with the SSL
stack.

If you do not associate an SSL policy with a particular proxy server, the proxy
server enables all the supported cipher suites and protocol versions by default.

Viewing SSL Policy

Step1  Click Setup from the task bar.

Step2  Click Policies from the left-most pane, then select SSL Policy from the object
selector. The policy information appears on the page.

Field Description
SSL Policies
Policy Name The name of the SSL policy.

Number of Proxy Services (Use Count) |Number of proxy services using the
SSL Policy.

Select a policy from the SSL Policies table, then Click Policy Tab to view the
policy details or click Associated Proxy Services tab to view the proxy services
associated with the policies

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Select a policy, then click Assign to Proxy Services to assign a policy to the

proxy services.

Click Add to add a TCP policy. The Add TCP Policy dialog box appears.
Select a policy, then click Edit to edit a TCP policy. The Edit TCP Policy dialog

box appears.

Select a policy, then click Delete to delete the policy.

SSL Policy Details

Field Description
Policy
Version The version of the SSL to one of the

following:

e ALL—Both SSL3 and TLS1
versions are used.

e SSL3—SSL version 3 is used.
e TLS1—TLS version 1 is used.

Close Protocol

Indicates whether the SSL
close-protocol behavior is present.

Session Cache

Indicates whether the session caching
is enabled.

Handshake Timeout (secs)

The amount of time the module keeps
the connection in handshake phase.

Absolute

Indicates whether the values should be
absolute values.

Session Timeout (secs)

The amount of time the module waits
for the session timeout.

Cipher Suites

The list of cipher-suites acceptable to
the proxy server.

Associated Proxy Services

Name

Name of the proxy service.

Type

Type of the proxy service.

For example: Server Proxy.

| oL-6014-02
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Field Description

Side The side to which the policy is applied.

Client Side (Virtual) The IP address of the virtual server.

Server The IP address of the server.

Oper Status Indicates the operational status of the
proxy service.

Status Indicates the status of the proxy
service.

Certificate Status of the certificate associated with
the proxy.

Adding SSL Policies

Step 1 Click Setup from the task bar.

Step2  Click Policies on the left-most pane, then select SSL Policy from the object
selector. The policy information appears on the page.

Step3  Click Add. The Add SSL Policy dialog box appears.

Field Description

Policy

Policy Name Enter a name for your new SSL Policy.

Version Select a version for the SSL Policy.
Values are:

e ALL—Both SSL3 and TLS1
versions are used.

e SSL3—SSL version 3 is used.
e TLS1—TLS version 1 is used.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Field Description
Close Protocol Indicate whether to use an SSL close
protocol.
Values are:

e SSL close protocol is not followed

e Follow strict SSL close protocol.

Handshake Timeout (Secs) Enter the handshake timeout in
seconds.Valid values are from O to
65535 seconds.

Absolute Indicates whether the values should be
absolute values.

Session Timeout (Secs) Enter the session timeout in seconds.
Valid values are from 0 to 72000
seconds.

Absolute Select the check-box to view the

absolute values.

Session Cache Select Enabled to enable session cache.
You can decide not to cache the session
by selecting Disabled.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Field Description

Session Cache Size The size of the Session Cache. Select
Absolute check-box to view the
absolute value.

Cipher Suite Select the cipher-suite from the list.

The Cipher-suites that are acceptable
to the proxy-server are:

e RSA_WITH_3DES_EDE_CBC_SH
A—RSA with 3des-sha.

e RSA_WITH_DES_CBC_SHA—RS
A with des-sha.

e RSA_WITH_RC4_ 128 MD5—RS
A with rc4-md>S.

e RSA_WITH_RC4_128_SHA—RSA
with rc4-sha.

e all—All supported ciphers.

Step4  Click OK to add the new SSL Policy.

Editing SSL Policies

Step 1 Click Setup from the task bar.

Step2  Click Policies from the left-most pane, then select SSL Policy from the object
selector. The policy information appears on the page.

Step3  Click Edit. The Edit SSL Policy dialog box appears.

Field ‘Description
Policy
Policy Name ‘Enter a name for your new SSL Policy.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Field Description
Version Select a version for the SSL Policy.
Values are:

e ALL—Both SSL3 and TLS1
versions are used.

e SSL3—SSL version 3 is used.
e TLS1—TLS version 1 is used.

Close Protocol Indicate whether to use an ssl close
protocol.

Values are:
e SSL close protocol is not followed

e Follow strict SSL close protocol.

Handshake Timeout (Secs) Enter the handshake timeout in
seconds.Valid values are from O to
65535 seconds.

Session Timeout (Secs) Enter the session timeout in seconds.
Valid values are from 0 to 72000
seconds.

Session Cache Select Enabled to enable session

cache. You can decide not to cache the
session by selecting Disabled.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Field Description

Session Cache Select Enabled to enable session
cache. You can decide not to cache the
session by selecting Disabled.

Cipher Suite Select the cipher-suite from the list.

The Cipher-suites that are acceptable
to the proxy-server are:

e RSA_WITH_3DES_EDE_CBC_SH
A—RSA with 3des-sha

e RSA_WITH_DES_CBC_SHA—RS
A with des-sha

e RSA_WITH_RC4_ 128 MD5—RS
A with rc4-md>5

e RSA_WITH_RC4_128_SHA—RSA
with rc4-sha

e al—All supported ciphers

Step4  Click OK to apply the new values.

Deleting SSL Policy

Step 1 Click Setup from the task bar.

Step2  Click Policies from the left-most pane, then select SSL Policy from the object
selector. The policy information appears on the page.

Step3  Select a Policy from the list, then click Delete.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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HTTP Header Insertion Policy

HTTP header insertion is performed for the following methods: GET, HEAD,
PUT, TRACE, POST, DELETE. HTTP header insertion is not performed for the
CONNECT method.

Note  You can configure up to 100 HTTP header insertion policies, each policy
consisting of up to 32 prefixes or headers. Prefix and custom headers can include
up to 240 characters.

You can insert the following header types:

¢ Client Certificate Headers--Allow the backend server to see the attributes of
the client certificate that the SSL module has authenticated and approved.
Client certificate headers are sent only once per session. The server is
expected to cache these values using the session ID, which is also inserted
with the headers. In subsequent requests, the server uses the session ID to
look up the cached client certificate headers on the server itself.

If the client does not send a certificate, the SSL handshake fails. There is no
data phase or header insertion.

— Client IP and Port Address Headers

Network address translation (NAT) changes the client IP address and
destination TCP port number information. When you specify Client IP
Port, the SSL module inserts the client IP address and TCP destination
port information in the HTTP header, allowing the server to see the client
IP address and destination port number.

— Custom Headers

When you specify a custom string, the SSL module inserts the
user-defined header verbatim in the HTTP header. You can configure up
to 16 custom headers per HTTP header policy. The custom string can
include up to 240 characters.

— Prefix

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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The SSL module adds the specified prefix to every inserted HTTP header.
Adding a prefix enables the server to identify connections as coming
from the SSL module, and not from other appliances. A prefix is not
added to standard HTTP headers from the client. The prefix_string can
be up to 240 characters.

e SSL Session Headers-- including the session ID, are used to cache client
certificates based on the session ID. Session headers are also cached based on
the session ID if the server wants to track connections based on a particular
cipher suite. The SSL module inserts the full session headers in the HTTP
request during full SSL handshake, but inserts only the session ID when the
session resumes.

When you configure the SSL module as a client, the SSL module inserts the
session ID of the connection between the module and the backend SSL server.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Viewing HTTP Header Insertion Policy

Step 1
Step 2

Click Setup from the task bar.

Click Policies from the left-most pane, then select HT TP Header Insertion
Policies from the object selector. The policy information appears on the page.

The following fields appear:

Fields Description

Policy Name Name of the policy.

Use Count Number of proxy services using the
policy.

Select a policy from the HTTP Header Insertion Policy table, then click Policy
Tab to view the policy details or click Associated Proxy Services tab to view the
proxy services associated with the policies

Select a policy, then click Assign to Proxy Services to assign a policy to the
proxy services.

Click Add to add a new TCP policy. The Add TCP Policy dialog box appears.

Select a policy, then click Edit to edit a TCP policy. The Edit TCP Policy dialog
box appears.

Select a policy, then click Delete to delete the policy.

| oL-6014-02
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Fields ‘Description

Policy

Policy Name ‘The name of the policy.

General

Prefix The prefix or the type of header.

Client Certificate Insertion

Indicates whether the client certificate
insertion is enabled.

Client Ip Port Insertion

Indicates whether the client IP Port
insertion is enabled.

Session Header Insertion

Indicates whether the Session Header
insertion is enabled.

Custom Headers

Header Name

The user-defined header verbatim in
the HTTP header.

Value

Value of the header.

Associated Proxy Services

Name The name of the proxy service
associated with the policy.
Type The type of the proxy service.

Example: Server Proxy.

Virtual Server

The IP address of the virtual server.

Server

The IP address of the server.

Oper Status

The operational status of the service.

Status

The status of the proxy service.

Certificate

The status of the certificate associated
with the proxy service.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Adding HTTP Header Insertion Policy

Step 1
Step 2

Step 3

Step 4

Click Setup from the task bar.

Click Policies from the left-most pane, then select HT TP Header Insertion
Policy from the object selector. The policy information appears on the page.

Click Add. The Add HTTP Header Insertion Policy dialog box appears:

Field Description

Policy

Policy Name Enter a name for your new policy.

Prefix Enter a prefix to be used with the
policy.

For example: cisco.com

Client Certificate Insertion Select Enabled to enable the client
certificate insertion.

Client IP Port Insertion Select Enabled to enable the client IP
port insertion.

Session Header Insertion Select Enabled to enable Session
Header Insertion.

Custom Headers

Header The user-defined header verbatim in
the HTTP header. You can include up
to 16 custom headers per HTTP header
policy.

Click Add to add the header name.

Value Enter a header name, then enter the
value.

Click Add to add a value to the header.

Click OK to add the new policy.

| oL-6014-02
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Editing HTTP Header Insertion Policy

Step1  Click Setup from the task bar.

Step 2 Click Policies from the left-most pane, then select HT TP Header Insertion
Policy from the object selector. The policy information appears on the page.

Step3  Click Edit. The Edit HTTP Header Insertion Policy dialog box appears:

Field Description

Policy

Policy Name Name of the policy.

Prefix Modify the existing prefix or you can

enter a new prefix.

Client Certificate Insertion Select Enabled to enable the client
certificate insertion.

Client IP port Insertion Select Enabled to enable the client IP
Port insertion.

Session Header Insertion Select Enabled to enable the Session
Header insertion.

Custom Headers

Header The user-defined header verbatim in
the HTTP header. You can configure
up to 16 custom headers per HTTP
header policy.

Value Enter the value.

Step4  Click OK to apply the modifications.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Deleting HTTP Header Insertion Policy

Step 1
Step 2

Step 3

Click Setup from the task bar.

Click Policies from the left-most pane, then select HT TP Header Insertion
Policy from the object selector. The policy information appears on the page.

Select a Policy from the list, then click Delete.

URL Rewrite Policy

Note

The URL rewrite feature supports the rewriting of redirection links. The system
scans only the Location: HTTP header field in the response from the server and
rewrites the rules accordingly. The URL rewrite feature does not support
embedded links.

The URL rewrite feature rewrites the protocol and the non-default port (default
ports are port 80 for cleartext and port 443 for SSL).

You can configure up to 100 URL rewrite policies, each policy consisting of up to
32 rewrite rules per SSL proxy service, up to 200 characters per rule.

Follow these guidelines for URL rewrite:

¢ Anexact URL match takes precedence over a wildcard rule. A suffix wildcard
rule takes precedence over a prefix wildcard rule.

For example, www.cisco.com takes precedence, then www.cisco.*, then
*, cisco.com.

¢ Enter only one suffix or prefix wildcard rule at one time. For example, do not
enter www.cisco.* and www.cisco.c* in the same policy. Similarly, do not
enter *w.cisco.com and *.cisco.com in the same policy.

e Do not enter two exact URL match rules in the same policy. For example, do
not enter www.cisco.com clearport 80 sslport 443 and www.cisco.com
clearport 81 sslport 444 in the same policy. In this case, the second rule
entered overwrites the first rule.

| oL-6014-02
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e URL rewrite is performed for both offload and backend (HTTP-to-HTTPS,
and HTTPS-to-HTTP). This includes port rewrites.

Viewing URL Rewrite Policy

Step 1
Step 2

Click Setup from the task bar.

Click Policies from the left-most pane, then select URL Rewrite Policy from the
object selector. The policy information appears on the page.

The following fields appear:

Fields Description

Policy Name The name of the URL-Rewrite policy.

Number of Proxy Services (Use Count) |Number of proxy services using the
SSL Policy.

Select a policy from the URL Rewrite Policy table, then Click Policy Tab to view
the policy details or click Associated Proxy Services tab to view the proxy
services associated with the policies

Select a policy, then click Assign to Proxy Services to assign a policy to the
proxy services.

Click Add to add a URL Rewrite Policy. The Add URL Rewrite Policy dialog box
appears.

Select a policy, then click Edit to edit a URL Rewrite Policy. The Edit URL
Rewrite Policy dialog box appears.

Select a policy, then click Delete to delete the policy.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Following are the URL Rewrite Policy details:

Fields Description

Policy

Policy Name Name of the selected policy.

URL Host String The host string of the URL.

HTTP Port The HTTP port to be used for the
traffic.

HTTPS Port The HTTPS port to be used for the
traffic.

Associated Proxy Services

Name The name of the associated proxy
service.
Type The type of the proxy service.
For example: Server Proxy.
Client Side The IP address of the virtual server.
Server The IP address of the server.
Oper Status The operational status of the server.
Certificate Status of the certificate associated with

the proxy service.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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Adding URL Rewrite Policy

Step1  Click Setup from the task bar.

Step2  Click Policies from the left-most pane, then select URL Rewrite Policy from the
object selector. The policy information appears on the page.

Step3  Click Add. The Add URL Rewrite Policy dialog box appears.

Field

Action/Description

Policy Name

Enter a name for the policy.

URL Host String

The host string of the url.

HTTP Port

The HTTP Port to be used for the
traffic.

HTTPS Port

The HTTPS port to be used for the
traffic.

URL Host String

Enter the URL host string for
rewriting, then click Add to create the
new URL Rewrite Rule.

HTTP Port

(Optional) Enter the clear port value.

The HTTP port specifies the port
portion of the URL to be rewritten. If
you do not enter a value, the default
value is used.

HTTPS Port

(Optional) Enter the HTTPS port
value.

The HTTPS port specifies the port
portion of the URL that should be
rewritten.If you do not enter a value,
the default value is used.

i User Guide for CiscoView Device Manager for the Cisco SSL Services Module
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You can specify URL alone. But you cannot add clear port and SSL port without
entering a URL value.

>,
Note  You can configure up to 32 rewrite rules per SSL proxy service, up to 240

characters per rule. You should enter only one suffix or prefix wildcard
character (*) only once per rewrite rule.

To remove a URL Rewrite Rule, select the rule from the table, then click Remove.

Click OK to add the new policy.

Editing URL Rewrite Policy

Step 1
Step 2

Step 3

Click Setup from the task bar.

Click Policies from the left-most pane, then select URL Rewrite Policy from the
object selector. The policy information appears on the page.

Select a policy, then click Edit. The Edit URL Rewrite Policy dialog box appears.
The following fields appear:

Field Action/Description

Policy Name Enter a name for the policy.

URL Host String The host string of the url.

HTTP Port The HTTP Port used for the traffic.

HTTPS Port The HTTPS port used for the traffic.

URL Host String Enter the URL for rewriting, then click
Add to create the new URL Rewrite
Rule.
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M  URL Rewrite Policy

Field

Action/Description

HTTP Port

(Optional) Enter the clear port value.

The HTTP port specifies the port
portion of the URL to be rewritten. If
you do not enter a value, the default
value is used.

HTTPS Port

(Optional) Enter the HTTPS port
value.

The HTTPS port specifies the port
portion of the URL that should be
rewritten. If you do not enter a value,
the default value is used

You can specify URL alone. But you cannot add Clear Port and SSL Port without

entering a URL value.

N

Note  You can configure up to 32 rewrite rules per SSL proxy service, up to 240
characters per rule. You should enter only one suffix or prefix wildcard
character (*) only once per rewrite rule.

To remove a URL Rewrite Rule, select the rule from the table, then click Remove.

Stepd  Click OK to modify values.
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URL Rewrite Policy I

Viewing URL Rules and Outcome

Step 1
Step 2

Step 3

Step 4

The URL Rules and Outcome dialog box helps you view the URL rules you have
set and the outcome of the rules.

To view URL Rules and Outcome:

Click Setup from the task bar.

Click Policies from the left-most pane, then select URL Rewrite Policy from the
object All Router View. The policy information appears on the page.

Select a policy from the table. The details appear on the URL Rewrite Policy
Details pane. If you have set a URL rewrite for the policy, The View Rules and
Outcome button will be active.

Click View Rules and Outcome. The Rules and Outcome dialog box appears.

To view rules and outcome for server proxy, Click Rules and Outcome for Client
Proxy tab. The following fields appear:

Field Action/Description
URLSs that Match URL match criterion.
URL Rewrite The new URL.

To view rules and outcome for server proxy, Click Rules and Outcome for
Server Proxy tab. The following fields appear:

Field Action/Description
URLSs that Match URL match criterion.
URL Rewrite The new URL.
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M  URL Rewrite Policy

Deleting URL Rewrite Policy

To delete a policy:

Step 1 Click Setup from the task bar.

Step2  Click Policies from the left-most pane, then select URL Rewrite Policy from the
object selector. The policy information appears on the page.

Step 3 Select a Policy from the list, then click Delete.

User Guide for CiscoView Device Manager for the Cisco SSL Services Module
m. oL-6014-02 |




CHAPTER

Managing VLANs

The SSL software supports only the normal-range VLANs (2 through 1005).
Limit the SSL Services Module configuration to the normal-range VLANSs.

VLAN IDs must be the same for the switch and the module.

Note  When you create VLANs using CVDM-SSLM, you must ensure that the
corresponding VLANS exist on the switch and configured to permit the SSL
VLANS.

The following topics are described in this section:
e Viewing VLANS, page 9-2
e Adding VLANS, page 9-3
e Editing VLANS, page 9-4
e Deleting VLANS, page 9-4
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Viewing VLANs

To view VLANSs configured on the module:

Step 1 Click Setup in the task bar.
Step2  Click VLANS in the left-most pane. The VLAN page appears.
Step3  Click VLANS group folder in the object selector.

The following fields appear:

Field Description

VLAN ID Identification number for the VLAN.

IP Address / Subnet Mask IP address or subnet mask of the
VLAN.

Subnet Subnet of the VLAN

Gateway The gateway IP address of the VLAN

Route

Destination Destination IP address.

Next Hop Next Hop IP address.

Click Add... to add a new VLAN.
To edit the VLAN settings, select a VLAN from the table, then click Edit....
To delete a VLAN, select a VLAN from the table, then click Delete.
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||
Adding VLANs
Step1  Click Setup in the task bar.
Step2  Click VLANS in the left-most pane. The VLAN page appears.
Step3  Click VLANSs group folder in the object Selector.
Step4  Click Add...
The following fields appear:
Field Description
VLANID (2 - 1005) Enter the VLAN ID. The value should
be between 2 and 1005.
IP Address Enter the VLAN IP address.
Net Mask Select the mask for the IP address.
Values are:
e 255.0.0.0
e 255.255.0.0
e 255.255.255.0
Gateway Enter the IP address of the gateway.
Route
Destination IP Address Enter the IP address of the destination.
Destination Netmask Enter the mask for the destination.
Step5  Click OK to add the new VLAN.
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Editing VLANs

Step 1
Step 2
Step 3
Step 4

Step 5

Click Setup in the task bar.

Click VLANS in the left-most pane. The VLAN page appears.

Click VLANSs group folder in the object selector.

Click Edit...
The following fields appear:

Field Description

VLAN ID The ID of the VLAN you have
selected.

IP Address Modify the IP address of the VLAN.

Mask Modify the mask to be used for the
VLAN.

Gateway Modify the IP address of the gateway.

Route

Destination IP Address

Enter the destination IP address.

Destination Netmask

Enter the destination netmask.

Click OK to apply the changes.

Deleting VLANs

Step 1
Step 2
Step 3
Step 4

Click Setup in the task bar.

Click VLAN:Ss in the left-most pane. The VLAN page appears.

Click VLANSs group folder in the object selector.

Click Delete.
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Viewing Statistics

CVDM-SSLSM allows you to view the statistics of the traffic through the SSL
Module. The values are not auto-refreshed. You can manually refresh the values.

CVDM-SSLSM provides statistical information on the following:
e TCP Statistics, page 10-2
e SSL Statistics, page 10-4
e PKI Statistics, page 10-13
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Figure 10-1 Statistics Page
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TCP Statistics

To view TCP Statistics:

Step 1 Click Setup in the task bar, then select Statistics from the left-most pane.

Step2  Select TCP Statistics from the Object Selector.

The following fields appear:
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Field

Description

Last Update Time

The time at which the statistics
information was last updated.

Show Counter Value Change (Delta)

Values are:

Delta—Select this option to view the
counter value change (delta) between
subsequent updates. When this option
is selected, the measurement period
between subsequent updates will be
displayed.

Absolute—Displays the cumulative
value.

Connection Statistics

Connections in Established State

Number of connections in
ESTABLISHED state.

Current in TIME-WAIT State

Number of connections in
TIME-WAIT state.

Connections Initiated

Number of TCP connections initiated
by the SSLSM.

Connections Dropped

Number of connections that were
dropped.

Connections Closed

Number of connections that were
closed.

Connections Accepted

Number of TCP connections accepted
by the SSLSM.

Click Update to refresh the values.
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SSL Statistics

To view SSL Statistics:

Step 1 Click Setup in the task bar, then select Statistics from the left-most pane.
Step2  Select SSL Statistics from the Object Selector.
The following fields are displayed:
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Field

Description

Last Update Time

The time at which the statistics
information was last updated.

Show Counter Value Change (Delta)

Values are:

Delta—Select this option to view the
counter value change (delta) between
subsequent updates. When this option
is selected, the measurement period
between subsequent updates will be
displayed.

Absolute—Displays the cumulative
value.

Connection Statistics

Active Connections

Number of Active SSL connections

Active Sessions

Number of Session IDs in use.

Connections in Handshake

Number of connections in the
Handshake phase.

Connections in Data

Number of connections in data phase.

Connections in Renegotiation

Number of connections in
re-negotiation phase.

Connections Attempted

Number of connections attempted.

Connections Completed

Number of connections that were
completed.

Renegotiations Attempted

Number of re-negotiations attempted.

Session Reuses

Number of times when the session got
reused.

Full Handshakes

Number of Full Handshakes
performed.

Resumed Handshakes

Number of resumed handshakes
performed.

Error Statistics
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Field

Description

No-Cipher Alerts

Number of Handshake Failure alerts
sent due to unsupported Cipher suites

No-Compress Alerts

Number of Handshake Failure alerts
sent due to unsupported compression
scheme.

Version Mismatch Alerts

Number of Handshake Failure alerts
sent due to unsupported SSL version.

Fatal Alerts Sent

Number of fatal alerts sent.

Fatal Alerts Received

Number of fatal alerts received.

Overload Drops

Number of connections that were
declined due to overload.

Session Failures

Number of instances when the
allocation failed.

Handshake Failures

Number of connections that failed in
the Handshake phase.

Data Failures

Number of connections that failed due
to data errors (Pad Error/Bad MAC
Error)

Pad Errors

Number of SSL records received with
error in padding.

Bad MAC Errors

Number of SSL records received with
Bad MAC.

Average Statistics

Connection Rate (conns/sec)

Number of connections in a second.

Full Handshakes/sec

Number of handshakes in a second.

Resumed Handshakes/sec

Number of handshakes resumed in a
second.

Handshake Failures/sec

Number of handshake failures in a
second.

SSLv3 Statistics

Connections Established

Number of SSLv3 connections
established.
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Field

Description

Handshake Failures

Number of SSLv3 handshakes failed.

TSLv1 Statistics

Number of TSLv1 connections.

Connections Established

Number of connections established.

Handshake Failures Number of handshakes failed.
Timeout Statistics
SYN Timeouts Number of SYN Timeouts.

Idle Timeouts

Number of Idle Timeouts.

Reassembly Timeouts

Number of Reassembly Timeouts.

FIN-WAIT?2 Timeouts

Number of FIN-WAIT?2 Timeouts.

Drop Statistics

Invalid MSS Drops

Connections dropped due to
unsupported MSS size.

Connection Buffer Pool Drops

Number of connection buffer pool
drops.

Packet Statistics (Transmit)

Total Packets

Number of packets transmitted

Data Packets

Number of data packets transmitted.

Retransmitted Packets

Number of packets retransmitted.

Packet Statistics (Receive)

Total Packets

Number of packets received

Packets in Sequence

Number of packets received in
sequence.

Packets out of sequence

Number of packets received out of
sequence.

Click Clear to clear the counter values on the SSLSM.
Click Update to refresh the values from the SSLSM.
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Proxy SSL Statistics Summary

You can view a summary of the statistics for the client and server proxy.

To view Proxy Service Statistics Summary:

Step 1 Click Setup in the task bar, then select Statistics from the left-most pane.
Step2  Select SSL Statistics > Client Proxy or Server Proxy from the Object Selector.
Step3  Click the Summary tab.

The following fields are displayed:

Field Description

Last Update Time The time at which the statistics
information was last updated.

Show Counter Values Change (Delta) |Values are:

Delta—Select this option to view the
counter value change (delta) between
subsequent updates. When this option
is selected, the measurement period
between subsequent updates will be
displayed.

Absolute—Displays the cumulative
value.
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The table displays the following details:

Field Description

Proxy Service The name of the proxy service.
Connections

Attempted Number of connected attempted.
Completed Number of completed connections.
Active Number of active connections.
Errors

Fatal Alarms

Number of Fatal Alarms.

Handshake Failures

Number of handshake failures.

Throughput (bytes)

Encrypted

Number of encrypted bytes.

Decrypted

Number of decrypted bytes.

Click Clear to clear the counter values on the SSLSM.
Click Update to refresh the values from the SSLSM.
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Proxy SSL Statistics - Proxy Services

You can view the statistics for the proxy service (client proxy and service proxy).

To view Proxy Service Statistics:

Step 1 Click Setup in the task bar, then select Statistics from the left-most pane.
Step2  Select SSL Statistics > Client Proxy or Server Proxy from the Object Selector.

Step3  Select any of the proxy service from the list of configured proxy services.
The following fields are displayed:

Field Description

Last Update Time The time at which the statistics
information was last updated.

Show Counter Value Change Values are:

Delta—Select this option to view the
counter value change (delta) between
subsequent updates. When this option
is selected, the measurement period
between subsequent updates will be
displayed.

Absolute—Displays the cumulative
value.
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The table displays the following details:

Field

Description

Proxy Service

The name of the proxy service. Click
the proxy service name to view the
details of the selected proxy service

Connections

Attempted Number of connected attempted.
Completed Number of completed connections.
Active Number of active connections.
Errors

Fatal Alarms

Number of Fatal Alarms.

Handshake Failures

Number of handshake failures.

Throughput (bytes)

Encrypted

Number of encrypted bytes.

Decrypted

Number of decrypted bytes.

Click Clear to clear the counter values on the SSLSM.
Click Update to refresh the values from the SSLSM.
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.Proxy Service SSL Statistics

Step 1
Step 2
Step 3

You can view the statistics for a single proxy service (client proxy and service

proxy).

To view Proxy Service Statistics:

Click Setup in the task bar, then select Statistics from the left-most pane.

Select SSL Statistics > Client Proxy or Server Proxy from the Object Selector.

Select any of the proxy service from the list of configured proxy services.

The following fields are displayed:

Field

Description

Connection Counters

Connections Attempted

Number of connections attempted.

Connections Completed

Number of connections that were
completed.

Full Handshakes

Number of Full Handshakes
performed.

Resumed Handshakes

Number of resumed handshakes
performed.

Active Connections

Connections in Handshake

Number of connections in the
Handshake phase.

Connections in Data

Number of connections in data phase.

Connections in Renegotiation

Number of connections in
re-negotiation phase.

Valid Sessions

Number of valid sessions.

Errors

Handshake Failures

Number of handshake failures.

Data Failures

Number of data failures.

Fatal Alerts Sent

Number of fatal alerts sent.

Fatal Alerts Received

Number of fatal alerts received.
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Field Description

No-cipher Alerts Number of no cipher alerts.

No-compress Alerts Number of no compress alerts.

Version Mismatch Alerts Number of version mismatch alerts.

Bad MAC Received Number of SSL records received with
Bad MAC.

Pad Errors Number of SSL records received with

error in padding.

Session Limit Exceeds

Throughput
Bytes Encrypted Number of bytes encrypted.
Bytes Decrypted Number of bytes decrypted.

Click Clear to clear the counter values on the SSLSM.
Click Update to refresh the values from the SSLSM.

PKI Statistics

To view PKI Statistics:

Step 1 Click Setup in the task bar, then select Statistics from the left-most pane.
Step2  Select PKI Statistics from the Object Selector.
The following fields are displayed:

Field Description

Last Update Time The time at which the statistics
information was last updated.

Valid Signatures Number of valid signatures.

Invalid Signatures Number of invalid signatures.
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Field

Description

Invalid Certificates

Number of invalid certificates.

Authentications with Warning (No
CRL Check)

Number of authentications with
warning.

Number of CRL Polling

Number of CRL polling.

Requests with no Peer Certificate

Number of requests received with no
peer certificate.

CRL Query Failures

Number of CRL queries failed.

Unauthorized Requests

Number of unauthorized requests.

No Certificate Chain

Number of requests without certificate
chains.

Root Certificate not Self-signed

Number of root certificates without
self-signature.

No DER Encoded Certificate

Number of Certificates without DER
encoding.

No Memory

Number of certificates failures due to
lack of memory.

Bad DER Certificate Length

Number of certificates with bad DER
certificate length.

Failed to get Key from Certificate

Number of requests that failed to get a
key from the certificate.

Click Clear to clear the counter values on the SSLSM.
Click Update to refresh the values from the SSLSM.
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